SAS® Enterprise Guide® 8.1 and SAS® Add-In 8.1 for Microsoft Office: Administrator’s Guide
Contents

Chapter 1 / Administering SAS Enterprise Guide ................................................................. 1
 About SAS Enterprise Guide ................................................................................................. 1
 Unique Features of SAS Enterprise Guide Explorer .......................................................... 2
 SAS Enterprise Guide Features Available on SAS 9 .......................................................... 3
 Deploy SAS Enterprise Guide with Customized Options ................................................... 3
 Create Desktop Shortcuts for Profiles .................................................................................. 4
 Managing Libraries with SAS Enterprise Guide Explorer ................................................. 4
 Configure SAS Enterprise Guide for Grid Computing ....................................................... 8
 Configure SAS Enterprise Guide for Parallel Execution .................................................... 9
 Configure SAS Enterprise Guide to Hide the Check for Updates Option .......................... 9
 Deploy a Custom Configuration File in SAS Enterprise Guide ........................................ 10
 Troubleshooting: Common Connectivity Issues .................................................................. 11

Chapter 2 / Administering SAS Add-In for Microsoft Office ............................................. 19
 About SAS Add-In for Microsoft Office .............................................................................. 19
 Files Created by SAS Add-In for Microsoft Office .............................................................. 19
 Deploy SAS Add-In with Customized Options ................................................................ 20
 Configure SAS Add-In for Microsoft Office to Hide the Check for Updates Option ........ 20
 Deploy a Custom Configuration File .................................................................................. 21
 Library Access for SAS Add-In for Microsoft Office .......................................................... 22

Chapter 3 / Migrating SAS Content ..................................................................................... 23
 About Migrating Content .................................................................................................... 23
 Migrating SAS Content in SAS Add-In for Microsoft Office ............................................. 23
 The Migration Wizard .......................................................................................................... 24
 Prepare to Use the Migration Wizard ................................................................................ 25
 Running the Migration Wizard ............................................................................................ 25
 The Migration Record File .................................................................................................. 26
 The Mapping File ................................................................................................................ 27
 The List of Files to Be Migrated .......................................................................................... 29

Chapter 4 / Managing Connection Profiles ......................................................................... 31
 About Connection Profiles .................................................................................................. 31
 Managing Connection Profiles in SAS Enterprise Guide Explorer ...................................... 31
 Select a Default SAS Workspace Server ............................................................................. 32
 Create an Automatic Default Connection Profile ............................................................... 33
 Create a Shared Profile Deployment with Automatic Updates ......................................... 33
 Create an Initial Custom Profile Deployment .................................................................. 34

Chapter 5 / Working with Roles and Capabilities ............................................................... 37
 Understanding Roles .......................................................................................................... 37
 Open or Import Capabilities ................................................................................................ 38
 Save and Distribute Capabilities ........................................................................................ 40
 Content Capabilities .......................................................................................................... 44
 Options Capabilities .......................................................................................................... 46
 Tools and Help Capabilities ............................................................................................... 48
 Data Capabilities ................................................................................................................. 51
<table>
<thead>
<tr>
<th>Chapter 6 / Common Administration Tasks</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>89</td>
</tr>
<tr>
<td>Access the Help Using Local PDF Files</td>
<td>90</td>
</tr>
<tr>
<td>Encryption</td>
<td>95</td>
</tr>
<tr>
<td>Library Access</td>
<td>95</td>
</tr>
<tr>
<td>Configure Access to a Locked-Down Server</td>
<td>97</td>
</tr>
<tr>
<td>Configure Your Environment to Use the Upload to CAS Task</td>
<td>97</td>
</tr>
<tr>
<td>Tasks That Require Other SAS Software</td>
<td>99</td>
</tr>
<tr>
<td>Configuration Properties</td>
<td>99</td>
</tr>
</tbody>
</table>
About SAS Enterprise Guide

SAS Enterprise Guide provides a programming and graphical interface for the SAS programming language. The Program Editor’s syntax coloring, syntax suggestion, autocompletion, integrated syntax Help, and macros assist you in writing SAS programs. Wizards and menu options enable you to quickly generate projects, tasks, and process flows. The process flows analyze data, create graphs, and
generate reports. Behind each process flow is a SAS program that you can execute and edit.

With SAS Enterprise Guide, you can access data in many formats and third-party databases, and in operating environments including UNIX, z/OS, and Windows.

If you build and maintain OLAP cubes using SAS OLAP Server, you can query those cubes using SAS Enterprise Guide.

When users connect to a SAS Metadata Server, the primary administrative application is SAS Management Console. Several additional administrative features are provided by the SAS Enterprise Guide Explorer application. If you run SAS Enterprise Guide without a SAS Metadata Server, then SAS Enterprise Guide Explorer is your administrative application.

Note: Use SAS Management Console or SAS Data Integration Studio to create and modify library definitions in metadata.

The following diagram depicts how you use administrative tools to create and access libraries.

Unique Features of SAS Enterprise Guide Explorer

SAS Enterprise Guide Explorer adds the following administrative features to those that are provided by SAS Management Console:

- administering a common environment configuration for SAS Enterprise Guide users
- importing tasks created on other instances of SAS Enterprise Guide
- deploying connection profiles between instances of SAS Enterprise Guide
SAS Enterprise Guide Features Available on SAS 9

Using SAS Enterprise Guide in a SAS 9 environment provides access to these features:
- stored processes
- information maps
- roles and capabilities
- SAS folders
- publishing

Deploy SAS Enterprise Guide with Customized Options

To deploy a standardized set of site-specific SAS Enterprise Guide options:

1. Install a copy of SAS Enterprise Guide on your system from your SAS software depot where you want to deploy your customized options.
2. In the installation directory, double-click SEGExplorer.exe to open SAS Enterprise Guide Explorer.
4. In the Options window, review and update each option in each category to meet the needs of your enterprise.
5. Click Save As to open the Save File window. Note the default storage location, and then click Save to update the file EGOptions.xml.
6. To deploy SAS Enterprise Guide with customized options, copy the file EGOptions.xml from your host into your SAS software depot. Copy the file into the top-level directory for SAS Enterprise Guide. Here is a typical network location:

```
\\depot-host\\Depot_date_type\\products\\eguide__release__win__en__sp0__1
\\depot-host\\Depot_date_type\\products\\eguide__release__wx6__en__sp0__1
```
Create Desktop Shortcuts for Profiles

After you create profiles, you can associate profiles with shortcuts on the Windows desktop. This capability enables you to start SAS Enterprise Guide with a specific profile by clicking a specific shortcut. You can also start SAS Enterprise Guide without a profile by using a desktop shortcut.

To associate a profile with a desktop shortcut:

1. Create a shortcut for the file SEGuide.exe. By default, the file is in one of the following directories:
   - for x64: `C:\Program Files\SASHome\SASEnterpriseGuide\version`.
   - for x32: `C:\Program Files\SASHome\x86\SASEnterpriseGuide\version`.

2. Right-click the shortcut that you created and select Properties.

3. To start SAS Enterprise Guide by using a specific profile, locate the path in the Target box. At the end of the path, add a blank space and type `/profile:profile-name`. If the profile name includes spaces, you must enclose the name in double quotation marks:
   ```
   "C:\Program Files\SASHome\SASEnterpriseGuide\x.x\SEGuide.exe" /profile:"Cube Query 1"
   ```

4. To use the shortcut to run SAS Enterprise Guide without a profile, add `/noprofile` to the end of the Target box:
   ```
   "C:\Program Files\SASHome\SASEnterpriseGuide\x.x\SEGuide.exe" /noprofile
   ```

5. Click OK.

Managing Libraries with SAS Enterprise Guide Explorer

Overview

SAS Enterprise Guide Explorer displays metadata objects in a tree. You can expand an element in the tree to view the contained objects. You might be asked to enter a user ID and password to view those objects.

When your user definition connects you to a SAS Metadata Server, you use SAS Management Console to create server definitions and library definitions. When the server definitions and library definitions are available, you can use SAS.
Management Console or SAS Enterprise Guide Explorer to manage libraries, tables, and logins.

For information about creating and managing servers, see SAS Intelligence Platform: Application Server Administration Guide. For additional information about configuring libraries on network servers, see SAS Intelligence Platform: Data Administration Guide.

About Libraries and Tables

Libraries are collections of files that are stored on servers and accessed from SAS Enterprise Guide. When you add a metadata definition for a library, you make the metadata definition available to all the network SAS Enterprise Guide installations that have access to a specific metadata repository. Access is also granted to all other applications that use the repository. The metadata definition for a library includes the path, engine, and other options for the library. The metadata definition corresponds to the information that is specified in a LIBNAME statement.

The options that are specified in a library definition work like the commands in an AUTOEXEC.BAT file. These LIBNAME statement options are stored on the client and executed when a SAS Enterprise Guide application connects to the specified SAS server.

Table definitions specify the tables and columns that are available within a library. You can create table definitions by using one of the following functions:

- using the Update Library Metadata function in SAS Enterprise Guide
- using the Register Tables function in SAS Management Console
- running the METALIB procedure in a SAS session (which synchronizes metadata with the physical contents of a library)
- using SAS Data Integration Studio to build a data warehouse

You can include authorization settings for both library and table definitions. The authorizations specify which libraries and tables a user can access and whether the user can change the contents of a library.

About the Metadata LIBNAME Engine

To understand how SAS Enterprise Guide assigns and accesses libraries, it is helpful to understand the metadata LIBNAME engine. The META engine enables you to use a LIBNAME statement to reference a metadata definition for a library, rather than specifying a physical location. By default, the META engine provides Read-Only access to a library, which prevents the library contents from being different from the library metadata.

If you use the METAOUT=DATA option in the LIBNAME statement, the META engine can access tables that are not defined in metadata but that exist in the physical library. This option enables you to add and modify tables in the library. However, any metadata authorization settings that have been applied to tables or columns in the library are enforced. If a SAS program changes the contents of a library that uses the METAOUT=DATA option, you must synchronize the physical data and the metadata. To synchronize the data, you can use the Register Tables function in SAS Enterprise Guide Explorer.
function in SAS Management Console, the METALIB procedure, or the Update Library Metadata task in SAS Enterprise Guide.

Beginning with SAS 9.4M3, if a DBMS library is set to PROMPT and the server version is the third maintenance release for 9.4 or later, then SAS Enterprise Guide prompts for user credentials and passes them to the META engine using the new DBUSER= and DBPASS= LIBNAME options. These options enable customers to supply credentials for libraries whose server definitions have an authentication type of Prompt defined. These options can also be used to override the predefined metadata authentication type. The credentials must be valid on the target DBMS.

Add a Library

The ability to add library definitions to metadata was removed from SAS Enterprise Guide Explorer 7.1. Users can still create ad hoc libraries using the Project Library Wizard in SAS Enterprise Guide, but the library definition is not stored in metadata. Administrators should create metadata library definitions using the New Library Wizard in SAS Management Console.

Create an Output Library

By default, SAS Enterprise Guide stores output data in the Sasuser, Work, or Egtask library, or in a user-created output library on a SAS server. To change the default output library, select Tools ⇒ Options ⇒ Output Library. You might want to change the default output directory to create a library that can be accessed by all SAS Enterprise Guide users.

Be sure not to direct output to the Work library on a UNIX or z/OS server, because that library is temporary in those operating environments.

To change your output directory, open SAS Management Console and select Data Library Manager, and then select New Library. Choose Pre-assigned Library as the library type to ensure that the library is assigned whenever the server starts. Ensure that the library is defined on all servers that are used with SAS Enterprise Guide.

Another strategy for changing your output library is to use SAS Management Console to add the LIBNAME statement for the library to all server definitions that are used by SAS Enterprise Guide. For new servers, include the statement in the SAS start-up statements field in the New Server wizard. For servers that have already been defined, include the LIBNAME statement in the Properties dialog box.

Assigning Libraries

When you view a SAS server in SAS Enterprise Guide or SAS Enterprise Guide Explorer, you see a list of libraries on the selected server. The list includes both libraries that are assigned and libraries that are unassigned.

Assigned libraries are libraries that are pre-assigned or assigned in an autoexec program. Unassigned libraries are libraries that have been defined in metadata but have not yet been assigned or accessed. To assign an unassigned library, right-click
the library and select Assign. If the library definition was created by SAS Enterprise Guide Explorer, the library is assigned using the method that was specified in the library definition. Otherwise, the library is assigned using the META engine in its default mode, which means that the library is Read-Only. The library contents also match the metadata definition, so physical tables that are not defined in metadata are not displayed. Furthermore, tables and columns are not displayed if the user is not authorized to see that data.

Reset a Library Login

When you are prompted for credentials when connecting to a library, those credentials are stored in metadata so that they can be used later. The Reset login option clears these credentials, so you are prompted for credentials the next time you connect to the library.

**Note:** You cannot use this option on libraries that have been assigned using the metadata LIBNAME engine (MLE).

**Note:** When you use this option on a DBMS library where the DBMS credentials are stored in a shared group, the metadata identity removes the shared credentials, preventing access to the library for all users. Within SAS Management Console, you can use the Reset login capability in the Options category to restrict users from accessing this option.

Manage Logins with SAS Enterprise Guide Explorer

To add, modify, or delete your logins, open SAS Enterprise Guide Explorer and select File → Manage Logins. The Login Manager dialog box lists your current logins. You can edit an existing login or add a new one.

In the Edit Login dialog box, you select an authentication domain from a list of available domains. These domains are created in SAS Management Console.

Configure SAS Enterprise Guide for Integrated Windows Authentication

You can configure SAS Enterprise Guide to communicate with the SAS Metadata Server using Integrated Windows authentication.

In SAS Enterprise Guide, complete these steps:

1. In the installation directory, double-click SEGExplorer.exe to open SAS Enterprise Guide Explorer.
2 Click **File ➤ Manage Profiles ➤ Add.**

3 Define a profile for the SAS Metadata Server by entering the **Name**, **Machine**, and **Port**. The **Description** is optional.

4 Click the **Remote** or **Local** button.

   **Note:** If SAS Enterprise Guide is on the same machine as the SAS Metadata Server, do not select **Local** in the connection profile and define the SAS Metadata Server port. The fully qualified machine name in the **Remote** field must be used.

5 Click the **Use Integrated Windows Authentication** button. It is not necessary to configure the **Advanced** properties of the connection profile. The SAS Metadata Server accepts Kerberos connections and NTLM connections using the original service principal name (SPN) that was generated. To force only Kerberos connections, see “Forcing Kerberos” in *SAS Intelligence Platform: Security Administration Guide*.

6 Click **Save**. The Connections window appears. Verify that the SAS Metadata Server is listed. Click **Close**.

   For more information, see “How to Configure Integrated Windows Authentication” in *SAS Intelligence Platform: Security Administration Guide*.

---

**Configure SAS Enterprise Guide for Grid Computing**

To configure a SAS grid to distribute the workload from SAS Enterprise Guide, use the SAS Grid Manager. For assistance, see *Grid Computing in SAS*.

You can use a SAS grid in these ways:

- Send jobs to a load-balanced SAS Workspace Server and specify grid as the load-balancing algorithm.

   **Note:** When SAS Workspace Servers are grid-launched, you should disable the grid options because the benefit of load-balancing has already been realized. To do this, specify a value of **Ignore** for the EGridPolicy extended attribute.

- Specify that a project is to run on a grid, by specifying the option **Use grid if available** in the Project Properties dialog box.

- Specify that a task is to run on a grid, by specifying the option **Use grid if available** in the task’s Properties dialog box.

- On the logical grid server, specify a value of Force for the EGridPolicy extended attribute to send all output from SAS Enterprise Guide to your grid. Or specify a value of Ignore for the extended attribute to never send jobs to the grid, regardless of the value of the **Use grid if available** option.

To run project submissions or tasks on separate grid nodes, select the project or task option **Allow parallel execution**. If parallel tasks or project submissions share
data, create pre-defined libraries on each grid node, and ensure that all tasks or project submissions write and read data from those libraries.

Configure SAS Enterprise Guide for Parallel Execution

In SAS Enterprise Guide, parallel execution of process flows requires the use of client-managed pooled SAS Workspace Servers. This feature causes SAS Enterprise Guide to open new workspace server sessions to enable parallel execution. As the sessions become idle, they terminate.

The parallel workspace server sessions cooperate and store results files in a temporary shared results directory. Results files are retrieved from that directory for display by SAS Enterprise Guide. The temporary shared results directory is deleted upon termination of the workspace server session.

The temporary shared results directory is created in a location that is subordinate to the path specified in the WORK= system option for the SAS Workspace Server.

In the z/OS operating environment, the WORK= system option must refer to a UNIX file system path to enable parallel execution of process flows. If the WORK= system option refers to a native MVS bound library, those features are disabled. The following specification places the WORK library in a UNIX file system directory:

\[
\text{WORK}=/\text{tmp}.
\]

To configure a SAS Workspace Server with the WORK= system option, specify

\[
\text{WORK}=/\text{tmp}
\]

in the following file:

\[
\text{config-dir}/\text{Lev1}/\text{SASApp}/\text{WorkspaceServer}/\text{sasv9_usermods.cfg}
\]

If your pooled SAS Workspace Servers are configured under a single SAS Application Server, you can set the WORK= system option once, in the following file:

\[
\text{config-dir}/\text{Lev1}/\text{SASApp}/\text{sasv9_usermods.cfg}
\]

To create client-enabled pooled SAS Workspace Servers, see \textit{SAS Intelligence Platform: Application Server Administration Guide}.

Configure SAS Enterprise Guide to Hide the Check for Updates Option

The \textit{Check for Updates} option is located on the \textit{Help} menu.

To hide the \textit{Check for Updates} option:

1. Create a backup of the \texttt{SEGuide.exe.config} file.

2. In the \texttt{SEGuide.exe.config} file, change the \texttt{appSettings} element by adding a \texttt{CheckForUpdates} key and \texttt{false} value as shown in the following code:

\[
<!-- \text{Example application settings} -->
\]
<appSettings>
  <add key="CheckForUpdates" value="false" />
</appSettings>

Note: Be sure to remove the default comment markers (<!−−−−> directly before and after the <add key= line in the SEGuide.exe.config file.

For example, change the following lines:

<!--
<add key="<key>" value="<value>">
−−
</add>
-->

The resulting line should look like this:

<add key="CheckForUpdates" value="false"/>

3  Save the file.

4  Open SAS Enterprise Guide. Select Help. Check for Updates should not appear.

If you hide the Check for Updates option using a configuration file, SAS Enterprise Guide disables both the automatic and the manual method of checking for updates.

Note: You can disable Check for Updates at installation time by deploying your custom SEGuide.exe.config file with the client installation.

Deploy a Custom Configuration File in SAS Enterprise Guide

You can deploy a custom SAS Enterprise Guide configuration file using the SAS software depot.

During the initial installation process, complete these steps:

1  Create a backup of the SEGuide.exe.config file from a SAS Enterprise installation directory.

2  Modify the SEGuide.exe.config file.

3  Save the modified SEGuide.exe.config file to the following locations in your SAS software depot:

   \depot-host\Depot_date_type\products\eguide__release_win_en_sp0__1
   \depot-host\Depot_date_type\products\eguide__release_wx6_en_sp0__1

4  Install SAS Enterprise Guide. The custom SEGuide.exe.config file is deployed.
Troubleshooting: Common Connectivity Issues

Unable to Connect to a Local SAS Installation

If SAS Enterprise Guide cannot connect to a local SAS installation, try these steps:


   Note: If you receive errors launching SAS Foundation, contact SAS Technical Support and provide them with the errors that you received.

2. Follow these steps to register SAS as the default COM server.
   a. As administrator, open the Command Prompt window and navigate to the default SASHome directory where the SAS.exe file resides. For this example, we are using SAS 9.4. Usually, the sas.exe file is located here: 
   C:\ProgramFiles\SASHome\SASFoundation\9.4
   b. Enter sas.exe-regserver and press Enter.

   Note: The command is successful if no message appears.
Launch SAS Enterprise Guide and verify that you can connect to the Local SAS server.

Note: If you continue to have issues connecting to the Local SAS Server, contact SAS Technical Support.

Unable to Connect to a Remote SAS Server Installation

When SAS Enterprise Guide cannot connect to a remote SAS server installation, perform the following tests on the SAS server or servers:

1. Verify that SAS Foundation can be launched on the server.

   Note: If you receive errors launching SAS Foundation, contact SAS Technical Support and provide them with the errors that you received.

2. Verify that the SAS Metadata Server and the SAS object spawner have been started.

3. Verify that the SAS Workspace Server can be validated in SAS Management Console.

   Right-click the server name and select Validate. When, the Information window appears, click OK.
For SAS Enterprise Guide to operate correctly, the application must be able to invoke a SAS session. To do that, you must have connectivity between SAS Enterprise Guide and your SAS servers. The following steps explain how you can use the SAS 9.4 release of the SAS Integration Technologies Configuration utility to test the connectivity to a local or remote installation of SAS.

To test for connectivity between SAS Enterprise Guide and SAS servers, follow these steps:


2. The initial SAS Integration Technologies Configuration Wizard page appears. Select the default, which is Test SAS Servers.

3. Select Enter a SAS server definition manually.

Click Next.
The SAS Server page appears and provides the SAS server connection details.
1 Select the type of server you want to test.

2 Select the connection protocol. Depending on the protocol selected, enter all the additional information required to connect to the server.

3 Select the security package that you want to use.
   - **Username/Password** works with any server. Specify the credentials necessary for the server being tested.
   - If your server is configured to support integrated authentication, you can specify the **Negotiate**, **Kerberos**, or **NTLM** security package.
     - If you selected **Kerberos** or **Negotiate**, you might need to specify a Service Principal Name (SPN). For more information about SSPI, integrated authentication, and security packages, see *SAS Intelligence Platform: Security Administration Guide*.
     - If you selected **Negotiate**, you can specify a list of security packages to use.

If you are testing a locally installed SAS server, select these options:
   - From the **Currently Testing** drop-down list, select **SAS Workspace Server**.
   - From the **Connection Protocol** drop-down list, select **COM**.
If you are testing a remote SAS Metadata Server, select these options:

- From the **Currently Testing** drop-down list, select **SAS Metadata Server**.
- From the **Connection Protocol** drop-down list, select **IOM Bridge**.
- From the **Encryption Level** drop-down list, select **Credentials**.
- For the **Encryption Algorithm**, enter **SAS Proprietary**.
- For the port, enter **8561**.
- From the **Security Package** drop-down list, select **Username/Password**.

4. **Select Test**. The connection tests can be successful or they can fail. Failures should provide details about the cause of the issues. If the problem cannot be resolved, contact **SAS Technical Support** and include the results.

---

**Firewall Issues and Disconnects**

When SAS Enterprise Guide workspace sessions become disconnected, the most common causes are due to physical or application firewalls. When SAS Enterprise Guide submits a job to a remote SAS server, the connection between the client and server is still present but inactive. SAS Enterprise Guide is waiting for the submitted job to complete on the server. At the time of submission, while waiting for the job to complete, system firewalls see this as an inactive client/server relationship. During
this time, if the submitted job takes longer to complete than the set system firewall time-out, then the connection between the client and server is severed by the firewall.

Here is the error message that is sent for firewall disconnect issues:

The object invoked has disconnected from its clients. (Exception from HRESULT: 0x80010108 (RPC_E_DISCONNECTED))

Prior to the SAS 9.3 release, the only solution to fix a firewall disconnect is to set the TCP time-out setting on the firewall to a value greater than the expected run time of the longest submitted job.

In the SAS 9.4 release, a new option was added to the OBJECTSERVERPARMS system option. The KEEPALIVE= parameter sends an event packet to inactive clients at a regular interval to prevent disconnection by network firewalls. KEEPALIVE= works with SAS Enterprise Clients 5.1 and later. For more information, see “OBJECTSERVERPARMS System Option” in SAS Intelligence Platform: Application Server Administration Guide.

SAS Enterprise Guide Crash

If SAS Enterprise Guide is crashing or freezing, see Usage Note 55414: Enabling logging in SAS® Enterprise Guide® 7.1 and later.

After the logging is enabled, attempt to re-create the crash or freeze. Send the corresponding log, along with any events recorded within the Windows Event Viewer with SAS Enterprise Guide as the source, to SAS Technical Support.
Administering SAS Add-In for Microsoft Office

**About SAS Add-In for Microsoft Office**

SAS Add-In for Microsoft Office extends Microsoft Office to use the power of SAS data access, analysis, and reporting directly from Microsoft Outlook, Excel, Word, and PowerPoint. To see the power of SAS in these applications, open the **SAS** tab or menu.


**Files Created by SAS Add-In for Microsoft Office**

By default, SAS Add-In for Microsoft Office generates various files, including configuration files and log files.

On Windows 7 and 8, by default, these files are located in `C:\Users\user-ID\AppData\Roaming\SAS\Add-InForMicrosoftOffice\version`.

On Windows XP, the files are located in `C:\Documents and Settings\user-ID\Application Data\SAS\Add-InForMicrosoftOffice\version`. 
A path that applies to all supported versions of Windows is `%APPDATA%\SAS\Add-InForMicrosoftOffice\version`.

Information that is shared between SAS Add-In for Microsoft Office and SAS Enterprise Guide, such as favorites, settings for SAS Central, and some views, is stored in `C:\Users\user-id\AppData\Roaming\SAS\SharedSettings\8.1`.

Metadata server profiles that are shared between SAS Add-In for Microsoft Office and SAS Enterprise Guide are stored in `C:\Users\user-id\AppData\Roaming\SAS\MetadataServerProfiles`.

---

### Deploy SAS Add-In with Customized Options

To deploy a standardized set of site-specific SAS Add-In for Microsoft Office options:

1. In the SAS Add-In for Microsoft Office client (for example, Microsoft Excel), click the `SAS` tab and select `Tools ⇄ Options`.
2. Adjust the options as desired.
3. Close the SAS Add-In for Microsoft Office client.
4. Locate the AMOOptions.xml file (usually located in `%appdata%\SAS\Add-InForMicrosoftOffice\version`).
5. Edit a copy of the AMOOptions.xml file to remove any user-specific settings such as pathnames.
6. To deploy SAS Add-In for Microsoft Office with customized options, copy AMOOptions.xml from your host machine into your SAS software depot. Copy the file into the top-level directory for SAS Add-In for Microsoft Office.

---

### Configure SAS Add-In for Microsoft Office to Hide the Check for Updates Option

The **Check for Updates** option is located on the **Help** menu.

To hide the **Check for Updates** option:

1. Create a backup of the `SAS.OfficeAddin.dll.config` file from a SAS Add-In for Microsoft Office installation directory. If the file does not exist, create a file called `SAS.OfficeAddin.dll.config` in the SAS Add-In for Microsoft Office installation directory. Here is an example of a configuration file:

```xml
<configuration>
    <assemblySettings>
        <add key="CheckForUpdates" value="false"/>
    </assemblySettings>
</configuration>
```
2 Modify the SAS.OfficeAddin.dll.config file.
Remove the default comment markers (<!-- -->) directly before and after the <add key> line.

<!--
<add key="<key>" value="<value>"/>
-->

The resulting line should look like this:

<add key="CheckForUpdates" value="false"/>

3 Save the file.

4 Open Excel. Select Help. Check for Updates should not appear.

If you hide the Check for Updates option using a configuration file, it disables both the automatic and the manual method of checking for updates.

Note: You can disable Check for Updates at installation time by deploying your custom SAS.OfficeAddin.dll.config file with the client installation.

Deploy a Custom Configuration File

You can deploy a custom SAS Add-In for Microsoft Office configuration file using the SAS software depot.

During the initial installation process, complete these steps:

1 Create a backup of the SAS.OfficeAddin.dll.config file from a SAS Add-In for Microsoft Office installation directory. If the file does not exist, create a file called SAS.OfficeAddin.dll.config in the SAS Add-In for Microsoft Office installation directory. Here is an example of a configuration file:

<configuration>
<assemblySettings>
  <!-- Example application settings -->
  <add key="<key>" value="<value>"/>
</assemblySettings>
</configuration>

2 Modify the SAS.OfficeAddin.dll.config file.

3 Save the modified SAS.OfficeAddin.dll.config file to the following locations in your SAS software depot:

\\depot-host\\Depot_date_type\\products\\msofficeint__release__win__en_sp0__1
\\depot-host\\Depot_date_type\\products\\msofficeint__release__wx6__en_sp0__1

4 Install SAS Add-In for Microsoft Office. The custom SAS.OfficeAddin.dll.config file is deployed.
Library Access for SAS Add-In for Microsoft Office

If the SAS add-in attempts to write data to a table on the SAS Metadata Server, and the structure of the updated table is different, the metadata is not updated. For this reason, it is advisable to regulate Write access to registered tables from Excel, Word, and PowerPoint. Read access, for the purposes of querying SAS OLAP cubes using Excel, requires no special consideration.

Access to registered libraries is determined in part by the library access method. By default, all libraries that are registered on the SAS Metadata Server are Read-only. SAS Add-In for Microsoft Office users cannot create, add, or delete tables. The default library access method can be changed. For more information, see “Library Access” on page 95.

CAUTION
To maintain referential integrity on the SAS Metadata Server, it is advisable to inform SAS Add-In for Microsoft Office users about their permissions to access registered libraries.
Migrating SAS Content

About Migrating Content

You migrate your SAS content for any combination of the following reasons:

- upgrade to a version of SAS Enterprise Guide or SAS Add-In for Microsoft Office
- move SAS Enterprise Guide projects to a new repository
- move your SAS Metadata Server
- update metadata references
- update file references in your SAS Enterprise Guide projects

Migrating SAS Content in SAS Add-In for Microsoft Office

You can migrate SAS content in your Microsoft Office files in two ways. You can refresh individual files, or you can migrate any number of files using the Migration Wizard.

Refreshing individual files updates the SAS content to the latest file format. In some cases, you can still open those files in previous versions of SAS Add-In for Microsoft Office, as described later in this section.
The Migration Wizard is particularly useful when you want to perform these tasks:

- migrate a large number of files to a new version of SAS Add-In for Microsoft Office
- migrate to a new metadata repository
- update multiple metadata references in your SAS content

For more information about the Migration Wizard, see SAS Enterprise Guide and SAS Add-In for Microsoft Office: Migration Wizard User’s Guide.

In SAS Add-In 8.1 for Microsoft Office and later, you can migrate individual documents by refreshing them in the latest version of SAS Add-In for Microsoft Office. You can open documents that contain SAS content that was generated with prior releases.

If you refresh a document from any previous release, and if you add new content in the 8.1 release, do not open the document in any previous release.

To ensure that you are using the latest version of the data, refresh any data sources in your document before you use this data in SAS Add-In for Microsoft Office. For example, measures that were available to a PivotTable in the 4.3 release might not be available in the 8.1 release because you are connecting to a different server for the 8.1 release. When you refresh your data, any measures that no longer exist are removed from the PivotTable.

When you refresh a document from a previous release, you might notice that the style for the output has changed. To work around this problem:

1. Before you refresh the content in 5.1 or later, select the content in Microsoft Excel, Microsoft Word, or Microsoft PowerPoint, and then click Properties.

2. In the Properties dialog box, select the style that you want to use, and then refresh the content in 5.1 or later.

The Migration Wizard

You migrate your SAS content with the Migration Wizard. The wizard updates the file format and metadata references in SAS Enterprise Guide projects. The wizard also updates metadata references in Microsoft Office files that include SAS content. SAS content is added to Microsoft Office files using SAS Add-In for Microsoft Office. The metadata references identify metadata objects that are defined on your SAS Metadata Server. The metadata objects in turn identify servers, libraries, cubes, stored processes, and information maps.

The Migration Wizard processes these types of files:

- SAS Enterprise Guide projects (*.egp)
- SAS Web Report Studio reports
- information maps created in SAS Information Map Studio
- OLAP cubes created in SAS Enterprise Guide and SAS OLAP Cube Studio
- Microsoft Excel files
- Microsoft Word documents
Microsoft PowerPoint presentations

You can run the Migration Wizard interactively. The interactive wizard helps you locate files for migration, identifies the metadata references in the files that you select, and enables you to change the metadata references.

The Migration Wizard generates a migration record file, which identifies all of the migrated files and all of the updates to metadata references in your projects. The wizard also generates a log file. In interactive mode, the wizard gives you the option to generate a migration record file and enables you to change the default storage location of the log file.

You can supply a migration record file to the wizard as input, along with an optional mapping file and an optional list of files to be migrated. You can edit the XML tags in all three input files.

Note: The Migration Wizard does not carry forward any of the roles or capabilities that you might have defined in the previous release. When you move to a new release, you need to re-enter your roles and capabilities.

Prepare to Use the Migration Wizard

Before you run the Migration Wizard, complete these steps:

1. Install the new versions of SAS Enterprise Guide and SAS Add-In for Microsoft Office.

2. To migrate SAS content in Microsoft Office files, ensure that SAS Add-In for Microsoft Office is installed on the host that runs the Migration Wizard.

3. Add any new metadata references to your existing SAS content. (The Migration Wizard does not add new metadata references.)

4. Move or copy your existing SAS content into its new repositories. Keep track of the projects, directories, and files for later use in the Migration Wizard, or you can build your own migration record file and list of files to be migrated for input to the wizard.

5. Update all metadata references on your SAS Metadata Server. Record the metadata changes for later use in the Migration Wizard, or you can create a mapping file as you go.

6. Store any of the three migration files in the following directory: MyDocuments\Application Data\SAS\BI Clients\version-number\Migration.

Running the Migration Wizard

To run the Migration Wizard:
1 Close all Microsoft Windows applications (other than Microsoft Explorer).

2 Open the Migration Wizard in one of these ways:
   - In the installation directory for SAS Enterprise Guide or SAS Add-In for Microsoft Office, double-click MigrationWizard.exe.

   Note: If you are not using a migration record file, note that the Migration Wizard does not process any files until you click Finish.

   - If you are supplying a migration record file as input, execute the Migration Wizard from a command line:
     
     MigrationWizard migration-record-filename

     For more information about each step in the Migration Wizard, see SAS Enterprise Guide and SAS Add-In for Microsoft Office: Migration Wizard User’s Guide.

---

### The Migration Record File

The Migration Wizard creates a new XML migration record file at the end of its process. The migration record file contains a reference to the applicable SAS Metadata Server, a list of files migrated, and a list of mappings. In this case, the term mappings refers to updates to metadata references.

When you run the Migration Wizard interactively, the wizard prompts you for a storage location for the migration record file. If you do not specify a location, the file is not generated.

When you run the Migration Wizard, you specify a migration record file as an input to the Migration Wizard. As a result, the wizard applies the specified set of mappings to the specified list of files.

You can use the following XML syntax to construct your own migration record file or to edit an existing migration record file. You also have the option of using a separate file to specify the list of files to be migrated. You can use a third file to specify your mappings (updates to metadata references). XML tags in the migration record file specify the locations of the mapping file and the list of files to be migrated.

The migration record file contains the following XML syntax (minus the comments):

```xml
<MigrationRecordFile filename="migration-record-file-name">
  <MetaDataServer profile="server-name" hostname="full-host-name" port="server-port-number">
  </MetaDataServer>

  <FileList>
    <File>
      <FullPath>full-path-to-file</FullPath>
    </File>
    <File>
      <FileType>Local</FileType>
      <FullPath>path-to-local-file</FullPath>
      <FullPath>network-path-to-local-file</FullPath>
    </File>
  </FileList>
</MigrationRecordFile>
```
The Mapping File

You can create a mapping file in XML to provide the Migration Wizard with a reusable and standardized set of updates for the metadata references in your SAS content. In the mapping file, you identify existing metadata references and specify new metadata definitions for those references. The result is that your SAS content contains metadata references that reflect the metadata definitions on your SAS Metadata Server.

When you run the Migration Wizard interactively, you are asked if you want to use a mapping file. If you opt to use a mapping file, the wizard searches all of the files to be migrated for the metadata references in the mapping file. When the wizard finds a metadata reference, it adds the intended change to the list of changes. At that point, you can approve or delete any of the intended updates to metadata references.

The mapping file must be stored in the same directory as the list of files to be migrated on the host that runs the Migration Wizard. The location is the application data directory of the user who runs the Migration Wizard: %APPDATA%\SAS\SharedSettings\version-number\Migration\filename.xml. In the Windows 7 operating environment, this path resolves to C:\Users\user-id\AppData\Roaming\SAS\SharedSettings\version-number\Migration\filename.xml.

When you run the wizard, you edit your migration record file to specify the name of the mapping file.

To create your mapping file, apply any number of the following MappedItem tags (named metadata objects) for your particular set of ReferenceTypes (object types):

```xml
<MappingInformation>
    <MappedItem>
        <ReferenceName>server-name</ReferenceName>
        <ReferenceID>server-id</ReferenceID>
        <ReferenceType>Server</ReferenceType>
        <CurrentMapping>old-server-definition</CurrentMapping>
        <NewMapping>new-server-definition</NewMapping>
    </MappedItem>
</MappingInformation>
```
<MappedItem>
  <ReferenceName>library-name</ReferenceName>
  <ReferenceID>library-id</ReferenceID>
  <ReferenceType>LIBRARY</ReferenceType>
  <CurrentMapping>old-library-definition</CurrentMapping>
  <NewMapping>new-library-definition</NewMapping>
</MappedItem>

<MappedItem>
  <ReferenceName>stored-process-name</ReferenceName>
  <ReferenceID>stored-process-id</ReferenceID>
  <ReferenceType>SAS.EG.ProjectElements.StoredProcess</ReferenceType>
  <CurrentMapping>old-stored-process-definition</CurrentMapping>
  <NewMapping>new-stored-process-definition</NewMapping>
</MappedItem>

<MappedItem>
  <ReferenceName>external-file-name</ReferenceName>
  <ReferenceID>external-file-id</ReferenceID>
  <ReferenceType>SAS.EG.ProjectElements.ExternalFile</ReferenceType>
  <CurrentMapping>old-external-file-definition</CurrentMapping>
  <NewMapping>new-external-file-definition</NewMapping>
</MappedItem>

<MappedItem>
  <ReferenceName>information-map-name</ReferenceName>
  <ReferenceID>information-map-id</ReferenceID>
  <ReferenceType>SAS.EG.ProjectElements.InformationMap</ReferenceType>
  <CurrentMapping>old-information-map-location</CurrentMapping>
  <NewMapping>new-information-map-location</NewMapping>
</MappedItem>

<MappedItem>
  <ReferenceName>cube-name</ReferenceName>
  <ReferenceID>cube-id</ReferenceID>
  <ReferenceType>SAS.EG.ProjectElements.Cube</ReferenceType>
  <CurrentMapping>old-cube-location</CurrentMapping>
  <NewMapping>new-cube-location</NewMapping>
</MappedItem>

<MappedItem>
  <ReferenceName>OLAP-catalog-name</ReferenceName>
  <ReferenceID>OLAP-catalog-ID</ReferenceID>
  <ReferenceType>OLAPCATALOG</ReferenceType>
  <CurrentMapping>old-catalog-definition</CurrentMapping>
  <NewMapping>new-catalog-definition</NewMapping>
  <OLAPCatalogName>old-OLAP-catalog-name</OLAPCatalogName>
  <OLAPServerName>old-OLAP-server-name</OLAPServerName>
  <OlapServerType>old-OLAP-server-type</OlapServerType>
  <OlapProviderName>old-OLAP-provider</OlapProviderName>
  <OlapLoginMode>old-login-mode</OlapLoginMode>
  <OlapExtProperties>old-extended-srvr-conn-props</OlapExtProperties>
  <OlapHostName>old-host-name</OlapHostName>
  <OlapPort>old-port</OlapPort>
  <NewOLAPCatalogName>new-OLAP-catalog-name</NewOLAPCatalogName>
  <NewOLAPServerName>new-OLAP-server-name</NewOLAPServerName>
  <NewOlapServerType>new-OLAP-server-type</NewOlapServerType>
  <NewOlapProviderName>new-OLAP-provider</NewOlapProviderName>
  <NewOlapLoginMode>new-login-mode</NewOlapLoginMode>
  <NewOlapExtProperties>new-extended-srvr-conn-props</NewOlapExtProperties>
</MappedItem>
The List of Files to Be Migrated

The Migration Wizard can use a list of files to be migrated when you execute the wizard from a command line. To create a list of files to be migrated, use the XML syntax for the FileList tag, as shown in "The Migration Record File" on page 26. In the migration record file, you replace the FileList tag with the LoadFileList tag. The LoadFileList tag specifies the name of the list of files to be migrated.

The list of files to be migrated must be stored in the same directory as the mapping file.
About Connection Profiles

After you install SAS Enterprise Guide or SAS Add-In for Microsoft Office, you can create either one or more connection profiles for the user or you can configure the application to not use a profile.

If you have a profile, you connect to a SAS Metadata Server by default when you start SAS Enterprise Guide or SAS Add-In for Microsoft Office. You can also select a profile to access a different SAS Metadata Server.

Connection profiles are shared between SAS Enterprise Guide and SAS Add-In for Microsoft Office. Any changes that you make in one application are reflected in the other application.

Managing Connection Profiles in SAS Enterprise Guide Explorer

To administer connection profiles, follow these steps:

1. In the installation directory for SAS Enterprise Guide or SAS Add-In for Microsoft Office, double-click SEGExplorer.exe to open SAS Enterprise Guide Explorer.

2. In the SAS Enterprise Guide Explorer, select File ▸ Manage Profiles.

3. In the Connections dialog box, select Profiles to add, modify, or delete connection profiles, or select Updates to specify and invoke a profile.
configuration file. Select Servers to specify the default SAS Workspace Server, as described in the next section.

4 Click Add to create a profile.

5 In the Create Profile dialog box, specify a server name and optional description.

6 For remote servers, enter a network name in the Machine box.

7 Confirm that Port is set to the correct SAS Metadata Server port number if the deployment does not use the default.

8 To authenticate users with the user ID and password that are defined in the Windows operating environment, select the Use Integrated Windows Authentication check box.

9 If an authentication domain has been implemented, enter the name of that domain in the Authentication domain box. Otherwise, leave the box blank. For information about authentication domains, see SAS Intelligence Platform: Security Administration Guide.

10 Click Save to add the new profile.

11 To activate the new profile, select it in the Connections dialog box and select Set Active. If a previous connection was active, it is closed and a new connection is opened. The selected profile is activated each time the user opens SAS Enterprise Guide or SAS Add-In for Microsoft Office. The active profile can be changed at any time.

---

Select a Default SAS Workspace Server

SAS Workspace Servers execute SAS programs and stored processes as they are requested by SAS Enterprise Guide.

To specify the server that runs SAS for a given instance of SAS Enterprise Guide or SAS Add-In for Microsoft Office, complete these steps:

1 In the installation directory for SAS Enterprise Guide or SAS Add-In for Microsoft Office, double-click SEExplorer.exe to open SAS Enterprise Guide Explorer.

2 In SAS Enterprise Guide Explorer, select File ➔ Manage Profiles.

3 Click Servers, and then click the down arrow to select a default SAS server.

---

Note: Performance improvements can be achieved when groups of users select a load-balancing cluster of SAS Workspace Servers. For information about load-balancing, see SAS Intelligence Platform: Application Server Administration Guide.

---

4 If a SAS Workspace Server exists on the local host and you want that server to appear in the list of servers, select Automatically add local SAS server (if installed) to the list. The server does not need to be registered on the SAS Metadata Server for this feature.
Create an Automatic Default Connection Profile

If you install from a planned deployment that contains a SAS Metadata Server, a default connection profile that points to that SAS Metadata Server is created for SAS Enterprise Guide and SAS Add-In for Microsoft Office.

Create a Shared Profile Deployment with Automatic Updates

SAS Enterprise Guide and SAS Add-In for Microsoft Office can update their profiles (manually or automatically) from a shared profile stored in a central location. After you define profiles, you can deploy those profiles across your enterprise. You can also automatically update your profiles when you initialize SAS Enterprise Guide or SAS Add-In for Microsoft Office. The automatic update specifies a set of profiles and an active profile.

To create a shared profile deployment and enable the automatic update of profiles:

1. In the installation directory for SAS Enterprise Guide or SAS Add-In for Microsoft Office, double-click SEGExplorer.exe to open SAS Enterprise Guide Explorer.


3. On page 1 of the wizard, read the wizard tasks and click Next.

4. On page 2, confirm that the desired active profile is selected. If you want a different profile to be active when the profiles are deployed, click Configure Profiles to change the active profile. Click Next.

5. On page 3, you can test each connection profile that is defined by clicking Begin Test. This step is optional. Click Next.

6. On page 4, specify a network-accessible storage location that clients can access when looking for the new SDSUpdate.xml update file. Ensure that the storage location can be accessed by all relevant instances of SAS Enterprise Guide and SAS Add-In for Microsoft Office.

7. On page 5, specify a local storage for SDSUpdate.xml and SDSControl.xml. This is a staging folder. You need to move the files to their appropriate respective locations to actually cause the updates to occur.

8. On page 6, click Finish to generate the configuration files.

9. When you click Finish, the Profile Deployment Wizard creates an SDSUpdate.xml file that contains the metadata connection data with all user names and passwords removed and an SDSControl.xml file that describes how the updates should be applied.
To deploy SAS Enterprise Guide with instructions to automatically update its profile from the shared profile, copy the SDSControl.xml file from your staging folder into your SAS software depot. Copy the file into the top-level directory for SAS Enterprise Guide. Here are typical network locations:

```\depot-host\Depot_date_type\products\eguide_release_win_en_sp0__1
\depot-host\Depot_date_type\products\eguide_release_wx6_en_sp0__1```

This causes the clients that are installed from this depot to examine the location specified on page 4 of the Profile Deployment Wizard for a new update file.

Copy the generated SDSUpdate.xml file to the path specified on page 4 of the Profile Deployment Wizard so that the clients retrieve that file and apply it the next time they are started.

You need to complete steps 12 through 15 manually only if the SDSControl.xml file was not deployed by the actions taken in step 10. If you complete step 10 when you install SAS Enterprise Guide from this depot, then steps 12 through 15 automatically happen on the client.

To enable the automatic update of profiles on other hosts, open SAS Enterprise Guide Explorer, open the File menu, and select Manage Profiles.

In the Connections window, select Updates.

Select Update profiles automatically.

In the Location of update file field, specify the network storage location of the file SDSUpdate.xml.

To update profiles immediately, click Check for updates now.

Create an Initial Custom Profile Deployment

Unlike the shared profile that is stored in a central location that both the SAS Enterprise Guide and the SAS Add-In for Microsoft Office clients can update from manually or automatically, the initial custom profile delivers the desired profile directly to each client during deployment. (Nothing is stored centrally.)

To create an initial custom profile deployment:

1. In the installation directory for SAS Enterprise Guide or SAS Add-In for Microsoft Office, double-click SEGExplorer.exe to open SAS Enterprise Guide Explorer.
3. On page 1 of the wizard, read the wizard tasks and click Next.
4. On page 2, click Configure Profiles to display the Connections dialog box. Click Add or Modify to specify the profiles that you plan to deploy. Select the profile that you want to be the active profile.
5. On page 3, click Begin Test to test your profiles. When you have finished the test, click Next.
6 On page 4, enter any path for the location of the update file and click **Next**. This path is not used when creating an initial custom profile deployment.

7 On page 5, specify a local storage location for the configuration files. The directory that you specify receives two files: SDSControl.xml and SDSUpdate.xml.

8 On page 6, click **Finish** to generate the configuration files. The SDSUpdate.xml file contains the profiles selected on page 2, but with user and password information removed.


10 Go to the directory specified on page 5 and rename SDSUpdate.xml to ConfigurationV8.xml. Delete the SDSControl.xml file.

11 Copy or move the new ConfigurationV8.xml from your local storage location to your SAS software depot. Locate the file in the two top-level en directories for SAS Enterprise Guide. Note that the files are added only to the English locale folders regardless of the languages being installed. Here are typical locations:

   ```
   \depot-host\Depot_date_type\products\eguide_release_win_en_sp0__1
   \depot-host\Depot_date_type\products\eguide_release_wx6_en_sp0__1
   ```

   As an advanced alternative to steps 1 through 10, for step 11 you can use a copy of an existing ConfigurationV8.xml file, located in `%APPDATA%\SAS\MetadataServerProfiles`. The Profile Deployment Wizard removes all user names and passwords from the file when creating the SASUpdate.xml file. So if you use this approach, you must manually edit the file to remove all **User** and **Password** elements.

1 Edit a copy of an existing ConfigurationV8.xml file from %APPDATA%\SAS\MetadataServerProfiles. Remove all **User** and **Password** elements from the XML file.

2 Copy or move the edited ConfigurationV8.xml file from your local storage location to your SAS software depot. Locate the file in the two top-level en directories for SAS Enterprise Guide. Note that the files are added only to the English locale folders regardless of the languages being installed. Here are typical locations:

   ```
   \depot-host\Depot_date_type\products\eguide_release_win_en_sp0__1
   \depot-host\Depot_date_type\products\eguide_release_wx6_en_sp0__1
   ```

   With the configuration file in place, you can now deploy SAS Enterprise Guide to new hosts from your depot with pre-configured profiles and a specified active profile.
Understanding Roles

Using SAS Management Console, you can assign users to roles, change the capabilities that are enabled by each role, and create roles with unique sets of capabilities.
The User Manager in SAS Management Console provides four default roles for SAS Enterprise Guide: Advanced, OLAP, Analysis, and Programming. There are three default roles for SAS Add-In for Microsoft Office: Advanced, OLAP, and Analysis.

Note: When you upgrade to a new release of SAS Enterprise Guide or SAS Add-In for Microsoft Office, you need to manually replace all non-default roles and capabilities.

Open or Import Capabilities

Table 5.1 Open or Import Category

<table>
<thead>
<tr>
<th>Capability</th>
<th>Description</th>
<th>Advanced Role</th>
<th>OLAP Role</th>
<th>Analysis Role</th>
<th>Programming Role (in SAS Enterprise Guide only)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browse LASR Libraries</td>
<td>Browse libraries that use the SASIOLA engine.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Import Data (in SAS Enterprise Guide only)</td>
<td>Perform the Import Data task.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Open Cube from OLAP Server</td>
<td>Open an OLAP cube source into a document.</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Open Data from Exchange (in SAS Enterprise Guide only)</td>
<td>Use menus and process flow diagrams to open files in Microsoft Exchange.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Advanced Role</td>
<td>OLAP Role</td>
<td>Analysis Role</td>
<td>Programming Role (in SAS Enterprise Guide only)</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------</td>
<td>-----------</td>
<td>---------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Open Data from OLEDB (in SAS Enterprise Guide only)</td>
<td>Use menus and process flow diagrams to open files using an installed OLE DB provider.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open Files from Local Computer</td>
<td>Open a file from the local file system. This is not a substitute for system security.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Open Files from SAS Server</td>
<td>View the server in the tree, navigate to the server, and open or import files. This is not a substitute for system security.</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>
Save and Distribute Capabilities

**Table 5.2  Save or Distribute Category**

<table>
<thead>
<tr>
<th>Capability</th>
<th>Description</th>
<th>Advanced Role</th>
<th>OLAP Role</th>
<th>Analysis Role</th>
<th>Programming (in SAS Enterprise Guide only)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Track Program History</td>
<td>Track changes made to SAS programs over time.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>(in SAS Enterprise Guide only)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Copy and Paste SAS Server Content</td>
<td>Copy and paste from a file on the SAS Server or in a SAS library. This is not a substitute for system security.</td>
<td>X</td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Export Data to Local Computer</td>
<td>Export data to the local file system. This is not a substitute for system security.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>(in SAS Enterprise Guide only)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Export Data to SAS Server</td>
<td>Export data to the SAS server file system. This is not a substitute for system security.</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>(in SAS Enterprise Guide only)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Advanced Role</td>
<td>OLAP Role</td>
<td>Analysis Role</td>
<td>Programming (in SAS Enterprise Guide only)</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
<td>---------------</td>
<td>-----------</td>
<td>---------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>Email SAS Content (in SAS Add-In for Microsoft Office only)</td>
<td>Send SAS content in an email, schedule a meeting, or assign a task from Microsoft Outlook only.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modify Output Data Location in SAS Tasks</td>
<td>Modify the output data location for the SAS tasks that enable the user to specify an output location.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Print SAS Content (in SAS Add-In for Microsoft Office only)</td>
<td>Print SAS content from Microsoft Outlook only.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print Data and Results (in SAS Enterprise Guide only)</td>
<td>Print data and results.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Publish to Distribution Channel (in SAS Enterprise Guide only)</td>
<td>Send content to distribution channels such as Email or Web by using the publish wizard.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Advanced Role</td>
<td>OLAP Role</td>
<td>Analysis Role</td>
<td>Programming (in SAS Enterprise Guide only)</td>
</tr>
<tr>
<td>----------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>---------------</td>
<td>-----------</td>
<td>-------------------------------------------------------------------------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>Save SAS Content (in SAS Add-In for Microsoft Office only)</td>
<td>Save SAS content to a file from Microsoft Outlook only.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save Files to Local Computer (in SAS Enterprise Guide only)</td>
<td>Save a file to the local file system. This is not a substitute for system security.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Save Files to SAS Server (in SAS Enterprise Guide only)</td>
<td>Save a file to the SAS server file system. This is not a substitute for system security.</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Save Program to Local Computer (in SAS Enterprise Guide only)</td>
<td>Save or export a program to the local file system. This is not a substitute for system security.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Save Project to SAS Server (in SAS Enterprise Guide only)</td>
<td>Save a project to the SAS server file system. This is not a substitute for system security.</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Advanced Role</td>
<td>OLAP Role</td>
<td>Analysis Role</td>
<td>Programming (in SAS Enterprise Guide only)</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>--------------------------------------------------</td>
<td>---------------</td>
<td>-----------</td>
<td>---------------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td>Save to SAS Folder (in SAS Enterprise Guide only)</td>
<td>Save a project to a SAS folder.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Send Content to Email Recipient (in SAS Enterprise Guide only)</td>
<td>Distribute files using email.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Send SAS Content to Internet Explorer (in SAS Enterprise Guide only)</td>
<td>Send SAS content to Internet Explorer.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Send SAS Content to JMP (in SAS Enterprise Guide only)</td>
<td>Send SAS content to JMP software.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Send SAS Content to Microsoft Office</td>
<td>Send SAS content to Microsoft Office applications.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Content Capabilities

### Table 5.3  Content Category

<table>
<thead>
<tr>
<th>Capability</th>
<th>Description</th>
<th>Advanced Role</th>
<th>OLAP Role</th>
<th>Analysis Role</th>
<th>Programming Role (in SAS Enterprise Guide only)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add or Modify Custom Code to SAS Tasks</td>
<td>Add or modify the custom code that runs before or after a SAS task.</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Analyze for Grid Computing (in SAS Enterprise Guide only)</td>
<td>Analyze a SAS program and create a version that is optimized for the SAS Grid Computing environment.</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Analyze for Process Flow (in SAS Enterprise Guide only)</td>
<td>Analyze a SAS program and create a process flow from the results.</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Create or Modify Advanced Query (in SAS Enterprise Guide only)</td>
<td>Create or modify advanced queries in the Query Builder.</td>
<td>X</td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Advanced Role</td>
<td>OLAP Role</td>
<td>Analysis Role</td>
<td>Programming Role</td>
</tr>
<tr>
<td>----------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>---------------</td>
<td>-----------</td>
<td>---------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Create or Modify Data Join in Advanced Query</td>
<td>Create or modify table joins in advanced queries.</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Create or Modify SAS Program</td>
<td>Open, create, and modify SAS code nodes in projects. If not granted, users can still execute SAS programs.</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Create or Modify SAS Stored Process</td>
<td>Create or modify stored processes in SAS Enterprise Guide projects.</td>
<td>X</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Comments</td>
<td>Add or modify comments in SAS Add-In for Microsoft Office projects.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Options Capabilities

**Table 5.4 Options Category**

<table>
<thead>
<tr>
<th>Capability</th>
<th>Description</th>
<th>Advanced Role</th>
<th>OLAP Role</th>
<th>Analysis Role</th>
<th>Programmi ng Role (in SAS Enterprise Guide only)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create or modify SAS programs from within a Microsoft Office document (in SAS Add-In for Microsoft Office only)</td>
<td>Open a file from the local file system. This is not a substitute for system security.</td>
<td></td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Allow HTML Results Format (in SAS Enterprise Guide only)</td>
<td>Generate results in HTML format.</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Allow Parallel Execution on the Same Server (in SAS Enterprise Guide only)</td>
<td>Enable or disable parallel execution on the same server.</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Advanced Role</td>
<td>OLAP Role</td>
<td>Analysis Role</td>
<td>Programmi ng Role (in SAS Enterprise Guide only)</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>--------------------------------------------------</td>
<td>---------------</td>
<td>-----------</td>
<td>---------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>Allow PDF Result Format</td>
<td>Generate results in PDF format.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>(in SAS Enterprise Guide only)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Allow RTF Result Format</td>
<td>Generate results in RTF format.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>(in SAS Enterprise Guide only)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modify All Options</td>
<td>Modify the options in the Options dialog box.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Modify Email Options</td>
<td>Modify the current email options for new and existing documents.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Modify Metadata Authorizations</td>
<td>Modify the metadata authorization settings for folders.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modify SAS Server Reference in Project or Document</td>
<td>Change the SAS server for all SAS content in the project or document.</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Tools and Help Capabilities

**Table 5.5** Tools and Help Category

<table>
<thead>
<tr>
<th>Capability</th>
<th>Description</th>
<th>Advanced Role</th>
<th>OLAP Role</th>
<th>Analysis Role</th>
<th>Programmiing Role (in SAS Enterprise Guide only)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify Security Options</td>
<td>Modify the current security options for new and existing documents.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reset Login</td>
<td>Remove the login from metadata that is associated with a server or library.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>

**Table 5.5** Tools and Help Category

<table>
<thead>
<tr>
<th>Capability</th>
<th>Description</th>
<th>Advanced Role</th>
<th>OLAP Role</th>
<th>Analysis Role</th>
<th>Programmiing Role (in SAS Enterprise Guide only)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Project Maintenance (in SAS Enterprise Guide only)</td>
<td>Rename servers and libraries throughout a project by using the Project Maintenance window.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Advanced Role</td>
<td>OLAP Role</td>
<td>Analysis Role</td>
<td>Programming Role (in SAS Enterprise Guide only)</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
<td>---------------</td>
<td>---------</td>
<td>-------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Access SAS Macro Variable Viewer (in SAS Enterprise Guide only)</td>
<td>Use the SAS Macro Variable Viewer tool, which is a convenient way to view SAS Macro variables and their values.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Access SAS Studio Tasks</td>
<td>Access SAS Studio Tasks.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Access SAS Technical Support</td>
<td>Navigate to the SAS Technical Support Website by using the <strong>SAS on the Web</strong> option.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Access Unregistere d Custom Tasks</td>
<td>Use custom tasks that are not registered in the metadata. By default, these custom tasks work unless the task is restricted by an administrator.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Assign Project Library (in SAS Enterprise Guide only)</td>
<td>Perform the Assign Project Library task.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Advanced Role</td>
<td>OLAP Role</td>
<td>Analysis Role</td>
<td>Programming Role (in SAS Enterprise Guide only)</td>
</tr>
<tr>
<td>-----------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------</td>
<td>-----------</td>
<td>---------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Browse Stored Process Server File System</td>
<td>Browse the file system on stored process servers using the SAS Enterprise Guide Explorer application.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create Library Metadata</td>
<td>Create libraries in metadata using SAS Enterprise Guide Explorer.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Create or Modify Schedules</td>
<td>Schedule when the SAS content in a document is refreshed. The user can also modify the scheduling options for a document.</td>
<td>X</td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>JMP Stored Process Packager</td>
<td>Define additional content for a SAS stored process that runs within JMP.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modify Styles</td>
<td>Modify the style of the SAS output.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>
### Data Capabilities

**Table 5.6 Data Category**

<table>
<thead>
<tr>
<th>Capability</th>
<th>Description</th>
<th>Advanced Role</th>
<th>OLAP Role</th>
<th>Analysis Role</th>
<th>Programming Role (in SAS Enterprise Guide only)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update Library Metadata (in SAS Enterprise Guide only)</td>
<td>Perform the Update Library Metadata task.</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Append Tables</td>
<td>Perform the Append Tables task.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Compare Data</td>
<td>Create a report that compares two data sets or compares two variables within or across data sets.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Create Format (in SAS Enterprise Guide only)</td>
<td>Perform the Create Format task.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Advanced Role</td>
<td>OLAP Role</td>
<td>Analysis Role</td>
<td>Programmi ng Role (in SAS Enterprise Guide only)</td>
</tr>
<tr>
<td>------------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>---------------</td>
<td>-----------</td>
<td>---------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Create Format from Data Set (in SAS Enterprise Guide only)</td>
<td>Create a SAS format using information in a SAS data set.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Cut and Paste Table Data (in SAS Enterprise Guide only)</td>
<td>Perform the cut and copy of table data.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Copy to SAS Server (in SAS Add-In for Microsoft Office)</td>
<td>Copy an active data source to SAS servers.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Data Set Attributes</td>
<td>Create a report with the data set's creation date, location, and number of observation s as well as the variable names, labels, types, and formats.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Delete Data Sets and Formats (in SAS Enterprise Guide only)</td>
<td>Perform the Delete Data Sets and Formats task.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Advanced Role</td>
<td>OLAP Role</td>
<td>Analysis Role</td>
<td>Programmi ng Role (in SAS Enterprise Guide only)</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>----------------------------------------------------------------------------</td>
<td>---------------</td>
<td>------------</td>
<td>--------------</td>
<td>-------------------------------------------------</td>
</tr>
<tr>
<td>Download Data Files to PC (in SAS Enterprise Guide only)</td>
<td>Perform the Download Data Files to PC task.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Edit Data Sets (in SAS Add-In for Microsoft Office only)</td>
<td>Change the values and column properties of a data set in Microsoft Excel.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Edit Data Sets (in SAS Enterprise Guide only)</td>
<td>Change the values and column properties of a data set in the data grid.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Explore Data (in SAS Enterprise Guide only)</td>
<td>Explore data in the interactive data explorer.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Extract Data from SAS Visual Analytics Reports</td>
<td>Extract the data that is contained in a SAS Visual Analytics report.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Extract Data from SAS Visual Analytics Reports</td>
<td>Extract the data that is contained in a SAS Visual Analytics report.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Advanced Role</td>
<td>OLAP Role</td>
<td>Analysis Role</td>
<td>Programming Role (in SAS Enterprise Guide only)</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-------------------------------------------------------</td>
<td>---------------</td>
<td>-----------</td>
<td>---------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>Import JMP</td>
<td>Import a JMP file.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>(in SAS Enterprise Guide only)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Import SPSS</td>
<td>Import an SPSS file.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>(in SAS Enterprise Guide only)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Import Stata</td>
<td>Import a Stata file.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>(in SAS Enterprise Guide only)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Random Sample</td>
<td>Perform the Random Sample task.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Rank</td>
<td>Compute ranks for one or more numeric variables across the observation of a SAS data set and send the ranks as output to a new SAS data set.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Sort Data</td>
<td>Sort a data source by any of its columns.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Advanced Role</td>
<td>OLAP Role</td>
<td>Analysis Role</td>
<td>Programmi\ning Role (in SAS Enterprise Guide only)</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------</td>
<td>-----------</td>
<td>---------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Split Columns</td>
<td>Create an output data set by splitting the unique combination of values of the selected columns in the input data set into multiple columns.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Stack Columns</td>
<td>Create an output data set by restructuring selected columns in the input data set so that these columns are transposed into observations.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Standardize Data</td>
<td>Standardize variables in a data source to a given mean and standard deviation. This task creates a SAS data set that contains the standardized values.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Advanced Role</td>
<td>OLAP Role</td>
<td>Analysis Role</td>
<td>Programming Role (in SAS Enterprise Guide only)</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------</td>
<td>-----------</td>
<td>---------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Transpose</td>
<td>Turn the selected columns of an input data source into the rows of an output data set.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Upload Data Files to Server</td>
<td>Perform the Upload Data Files to Server task.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Upload to LASR</td>
<td>Load a data source into a SAS LASR Analytics server.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>
### Describe Capabilities

#### Table 5.7 Describe Category

<table>
<thead>
<tr>
<th>Capability</th>
<th>Description</th>
<th>Advanced Role</th>
<th>OLAP Role</th>
<th>Analysis Role</th>
<th>Programming Role (in SAS Enterprise Guide only)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Characterize Data</td>
<td>Create a summary report, graphs, and frequency and univariate SAS data sets that describe the main characteristics of the data.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Distribution Analysis</td>
<td>Create a data summary. This task also provides information about the distribution of numeric variables and can be used to create a variety of plots.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Advanced Role</td>
<td>OLAP Role</td>
<td>Analysis Role</td>
<td>Programming Role (in SAS Enterprise Guide only)</td>
</tr>
<tr>
<td>----------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>---------------</td>
<td>-----------</td>
<td>---------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>List Data</td>
<td>Print the observations in a SAS data set, using all or some of the variables. The user can create a variety of reports.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>List Report Wizard</td>
<td>Create detail or summary reports.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>One-Way Frequencies</td>
<td>Generate frequency tables from the data. The user can also use this task to perform binomial and chi-square tests.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Summary Statistics</td>
<td>Compute descriptive statistics for variables across all observations and within groups of observations. The user can also summarize data in a graphical display.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Advanced Role</td>
<td>OLAP Role</td>
<td>Analysis Role</td>
<td>Programmi ng Role (in SAS Enterprise Guide only)</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>---------------</td>
<td>-----------</td>
<td>---------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Summary Tables</td>
<td>Display descriptive statistics in tabular format, using some or all of the variables in a data set. The user can create a variety of tables.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Table Analysis</td>
<td>Generate crosstabulation tables, also known as contingency tables, from the data.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>
# Graph Capabilities

**Table 5.8 Graph Category**

<table>
<thead>
<tr>
<th>Capability</th>
<th>Description</th>
<th>Advanced Role</th>
<th>OLAP Role</th>
<th>Analysis Role</th>
<th>Programming Role (in SAS Enterprise Guide only)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area Plot</td>
<td>Create area, spline, step, or overlay plots that show the mathematical relationship between two variables.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Bar Chart</td>
<td>Create vertical, horizontal, or three-dimensional bar charts that compare numeric values or statistics between different values of a chart variable.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Advanced Role</td>
<td>OLAP Role</td>
<td>Analysis Role</td>
<td>Programmi ng Role (in SAS Enterprise Guide only)</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------</td>
<td>-----------</td>
<td>---------------</td>
<td>-------------------------------------------------</td>
</tr>
<tr>
<td>Bar-Line Chart</td>
<td>Create a vertical bar chart with a line plot overlay. The line plot represents the value of a statistic that is calculated for one of the variables in the input data set.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Box Plot</td>
<td>Create box plots, high-low charts, or high-low-close charts that display multiple summary statistics for some numeric variable across different values of a chart variable.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Advanced Role</td>
<td>OLAP Role</td>
<td>Analysis Role</td>
<td>Programming Role (in SAS Enterprise Guide only)</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
<td>---------------</td>
<td>-----------</td>
<td>---------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>Bubble Plot</td>
<td>Create simple bubble plots. The bubbles are circles of varying proportions at data points that are plotted on the vertical and horizontal axes.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Contour Plot</td>
<td>Create line, filled, pattern, or smooth plots that show the mathematical relationship between three numeric variables.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Donut Chart</td>
<td>Create simple or group charts that show the relative contribution of the parts to the whole. The data appears as wedge-shaped slices of a circle.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Advanced Role</td>
<td>OLAP Role</td>
<td>Analysis Role</td>
<td>Programmi ng Role (in SAS Enterprise Guide only)</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------</td>
<td>-----------</td>
<td>---------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Line Plot</td>
<td>Create line, scatter, spline, needle, step, regression, smooth, STD, Lagrange interpolation, or overlay plots that show the mathematical relationship between variables.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Map Chart</td>
<td>Create a two-dimensional (choropleth) or three-dimensional (block and prism) color map that shows the variation in the value of a response variable for different geographic areas.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Open ODS Graphics Designer</td>
<td>Open the ODS Graphics Designer.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Advanced Role</td>
<td>OLAP Role</td>
<td>Analysis Role</td>
<td>Programmi ng Role (in SAS Enterprise Guide only)</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------</td>
<td>-----------</td>
<td>---------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Pie Chart</td>
<td>Create simple, group, or stacked charts that represent the relative contribution of the parts to the whole. The data appears as wedge-shaped slices of a circle.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Radar Chart</td>
<td>Create radar (or star) charts that show the relative frequency of data measures in quality control or market research problems.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Scatter Plot</td>
<td>Create two-dimensional scatter plots, three-dimensional scatter plots, or three-dimensional needle plots that show the relationships between two or three variables.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Advanced Role</td>
<td>OLAP Role</td>
<td>Analysis Role</td>
<td>Programming Role (in SAS Enterprise Guide only)</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------</td>
<td>-----------</td>
<td>---------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>Scatter Plot Matrix</td>
<td>Create a matrix of scatter plots.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Show ODS Statistical Graph</td>
<td>Show ODS Statistical Graph from an SGD file.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Surface Plot</td>
<td>Create three-dimensional wireframe plots, smooth plots, or gradient plots that show the mathematical relationship between three numeric variables.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Tile Chart</td>
<td>Create a tile chart. Each unique category combination is represented by a rectangular tile whose size and color are determined by the response variables.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>
## ANOVA Capabilities

### Table 5.9 ANOVA Category

<table>
<thead>
<tr>
<th>Capability</th>
<th>Description</th>
<th>Advanced Role</th>
<th>OLAP Role</th>
<th>Analysis Role</th>
<th>Programming Role (in SAS Enterprise Guide only)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linear Models</td>
<td>Analyze data within the framework of general linear models. This task uses the method of least squares to fit general linear models.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Mixed Models</td>
<td>Fit a variety of mixed linear models to data and use these fitted models to make statistical inferences about the data.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Advanced Role</td>
<td>OLAP Role</td>
<td>Analysis Role</td>
<td>Programming Role (in SAS Enterprise Guide only)</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------</td>
<td>-----------</td>
<td>---------------</td>
<td>-------------------------------------------------</td>
</tr>
<tr>
<td>Nonparametric One-Way ANOVA</td>
<td>Run nonparametric tests for location. The task also scales differences across a one-way classification and provides a standard analysis of variance on the raw data.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>One-Way ANOVA</td>
<td>Test for differences among the means of the levels and quantify the differences.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>t Test</td>
<td>Perform t tests for one sample, two samples, and paired observations.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>
Regression Capabilities

Table 5.10  Regression Category

<table>
<thead>
<tr>
<th>Capability</th>
<th>Description</th>
<th>Advanced Role</th>
<th>OLAP Role</th>
<th>Analysis Role</th>
<th>Programmi ng Role (in SAS Enterprise Guide only)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generalized Linear Models</td>
<td>Model data that is not normally distributed. This task can also model data for which the mean has been restricted to a range of values or data for which the variance is not constant.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>HP Linear Regression</td>
<td>Perform linear regression analysis on multiple dependent and independent variables using a high-performance distributed environment.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>
## Regression Capabilities

<table>
<thead>
<tr>
<th>Capability</th>
<th>Description</th>
<th>Advanced Role</th>
<th>OLAP Role</th>
<th>Analysis Role</th>
<th>Programming Role (in SAS Enterprise Guide only)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logistic Regression</td>
<td>Investigate the relationship between discrete responses and a set of explanatory variables using a high-performance distributed environment.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Linear Regression</td>
<td>Perform linear regression analysis on multiple dependent and independent variables.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Logistic Regression</td>
<td>Investigate the relationship between discrete responses and a set of explanatory variables.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>
### Multivariate Capabilities

#### Table 5.11  Multivariate Category

<table>
<thead>
<tr>
<th>Capability</th>
<th>Description</th>
<th>Advanced Role</th>
<th>OLAP Role</th>
<th>Analysis Role</th>
<th>Programming Role (in SAS Enterprise Guide only)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Canonical Correlation</td>
<td>Examine the relationship between a linear combination of a set of X variables and a linear combination of a set of Y variables.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

### Nonlinear Regression

Produce least squares or weighted least squares estimates of the parameters of a nonlinear model.
<table>
<thead>
<tr>
<th>Capability</th>
<th>Description</th>
<th>Advanced Role</th>
<th>OLAP Role</th>
<th>Analysis Role</th>
<th>Programming Role (in SAS Enterprise Guide only)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster Analysis</td>
<td>Create hierarchical clusters of the observations in a SAS data set that contains either coordinate data or distance data.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Correlations</td>
<td>Determine the relationship between numeric variables. The relationship is described by calculating correlation coefficients for the variables.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Discriminant Analysis</td>
<td>Develop a discriminant criterion that can be used to classify the values of the quantitative variables into the groups defined by the classification variable.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Advanced Role</td>
<td>OLAP Role</td>
<td>Analysis Role</td>
<td>Programmi ng Role (in SAS Enterprise Guide only)</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------</td>
<td>-----------</td>
<td>---------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>Factor Analysis</td>
<td>Perform a variety of common factor and component analyses and rotations.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Principal Components</td>
<td>Examine relationship among several quantitative variables. This task can be used for summarizing data and detecting linear relationships.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>
## Survival Analysis Capabilities

**Table 5.12  Survival Analysis Category**

<table>
<thead>
<tr>
<th>Capability</th>
<th>Description</th>
<th>Advanced Role</th>
<th>OLAP Role</th>
<th>Analysis Role</th>
<th>Programming Role (in SAS Enterprise Guide only)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Life Tables</td>
<td>Compute nonparametric estimates of the survival distribution of data that might be right-censored due either to withdrawals or to termination of the study.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Proportional Hazards</td>
<td>Perform regression analysis of survival data based on the Cox proportional hazards model.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>
## Capability Task Capabilities

### Table 5.13 Capability Category

<table>
<thead>
<tr>
<th>Capability</th>
<th>Description</th>
<th>Advanced Role</th>
<th>OLAP Role</th>
<th>Analysis Role</th>
<th>Programming Role (in SAS Enterprise Guide only)</th>
</tr>
</thead>
<tbody>
<tr>
<td>CDF Plots</td>
<td>Plot the observed cumulative distribution function (CDF) of a variable.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Histograms</td>
<td>Compare the distribution of measurements from a process in statistical control to its specification limits.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>P-P Plots</td>
<td>Compare the empirical cumulative distribution function (ECDF) of a variable to a specified theoretical cumulative distribution function, such as the normal distribution.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Advanced Role</td>
<td>OLAP Role</td>
<td>Analysis Role</td>
<td>Programmi ng Role (in SAS Enterprise Guide only)</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------</td>
<td>-----------</td>
<td>---------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Probability Plots</td>
<td>Compare ordered values of a variable to the percentiles of a specified theoretical distribution, such as the normal distribution.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Q-Q Plots</td>
<td>Compare ordered values of a variable to the quantiles of a specified theoretical distribution, such as the normal distribution.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Control Charts Capabilities

Table 5.14  Control Charts Category

<table>
<thead>
<tr>
<th>Capability</th>
<th>Description</th>
<th>Advanced Role</th>
<th>OLAP Role</th>
<th>Analysis Role</th>
<th>Programmi ng Role (in SAS Enterprise Guide only)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Box Chart</td>
<td>Create a mean chart for the subgroup means. The task superimposes the box-and-whisker plots of the measurements for each subgroup onto the mean chart.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>c Chart</td>
<td>Create c charts for the numbers of nonconformities (defects) in the subgroup samples.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Individual Measurements Chart</td>
<td>Create control charts for the individual measurements and the moving ranges.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Advanced Role</td>
<td>OLAP Role</td>
<td>Analysis Role</td>
<td>Programmi ng Role (in SAS Enterprise Guide only)</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------</td>
<td>-----------</td>
<td>---------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Mean and Range Chart</td>
<td>Create mean and range charts for the subgroup means and the subgroup ranges.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mean and Standard Deviation Chart</td>
<td>Create mean and standard deviation charts for the subgroup means and the subgroup standard deviations.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>np Chart</td>
<td>Create np charts for the numbers of nonconformities (defects) in the subgroup samples.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>p Chart</td>
<td>Create p charts for the proportions of nonconforming (defective) items in the subgroup samples.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Advanced Role</td>
<td>OLAP Role</td>
<td>Analysis Role</td>
<td>Programming Role (in SAS Enterprise Guide only)</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
<td>---------------</td>
<td>-----------</td>
<td>---------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>u Chart</td>
<td>Create u charts for the numbers of nonconformities (defects) per inspection unit in the subgroup samples that contain arbitrary numbers of units.</td>
<td></td>
<td></td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>
## Pareto Capabilities

**Table 5.15  Pareto Category**

<table>
<thead>
<tr>
<th>Capability</th>
<th>Description</th>
<th>Advanced Role</th>
<th>OLAP Role</th>
<th>Analysis Role</th>
<th>Programming Role (in SAS Enterprise Guide only)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pareto Chart</td>
<td>Create a chart that displays the relative frequency of problems in a process as bars. Pareto charts help the user identify the problems that deserve the most attention.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Time Series Capabilities

**Table 5.16  Time Series Category**

<table>
<thead>
<tr>
<th>Capability</th>
<th>Description</th>
<th>Advanced Role</th>
<th>OLAP Role</th>
<th>Analysis Role</th>
<th>Programming Role (in SAS Enterprise Guide only)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ARIMA Modeling and Forecasting</td>
<td>Analyze and forecast equally spaced univariate time series data, transfer function data, and intervention data by using the ARIMA or ARMA model.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Basic Forecasting</td>
<td>Generate forecasts for many time series in one step. This task uses extrapolative forecasting methods where the forecasts for a series are functions only of time and past values.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Advanced Role</td>
<td>OLAP Role</td>
<td>Analysis Role</td>
<td>Programming Role (in SAS Enterprise Guide only)</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------</td>
<td>-----------</td>
<td>---------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Create Time Series Data</td>
<td>Convert transactional data into fixed-interval time series. Transactional data is time-stamped data that is collected over time with irregular or varied frequency.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Forecast Studio Create Project</td>
<td>Specify the forecasting variables, choose whether to forecast your data hierarchically, and specify the forecast horizon for a new SAS Forecast Studio project.</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Forecast Studio Open Project</td>
<td>Open the selected series from an existing SAS Forecast Studio project and specify how to display the results.</td>
<td>X</td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Capability</td>
<td>Description</td>
<td>Advanced Role</td>
<td>OLAP Role</td>
<td>Analysis Role</td>
<td>Programming Role (in SAS Enterprise Guide only)</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------</td>
<td>-----------</td>
<td>---------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Forecast Studio Override Project</td>
<td>Submit overrides for the forecast data in an existing SAS Forecast Studio project.</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Prepare Time Series Data</td>
<td>Prepare data for analysis by other time series tasks. This task can also be used to perform generic transformations on data that is intended for use in any other tasks.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Regression Analysis of Panel Data</td>
<td>Estimate and forecast linear regression models for time series data when the errors are not independent through time or the error variance is not constant.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>
### Regression Analysis with Autoregressive Errors

Estimate and forecast linear regression models for time series data when the errors are not independent through time or the error variance is not constant.

<table>
<thead>
<tr>
<th>Capability</th>
<th>Description</th>
<th>Advanced Role</th>
<th>OLAP Role</th>
<th>Analysis Role</th>
<th>Programming Role (in SAS Enterprise Guide only)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regression Analysis with Autoregressive Errors</td>
<td>Estimate and forecast linear regression models for time series data when the errors are not independent through time or the error variance is not constant.</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

---

**Data Mining Capabilities**

*Table 5.17  Data Mining Category*

<table>
<thead>
<tr>
<th>Capability</th>
<th>Description</th>
<th>Advanced Role</th>
<th>OLAP Role</th>
<th>Analysis Role</th>
<th>Programming Role (in SAS Enterprise Guide only)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model Scoring</td>
<td>Score a data set against an existing SAS Enterprise Miner predictive model.</td>
<td>X</td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>
### Capability Description

<table>
<thead>
<tr>
<th>Capability</th>
<th>Advanced Role</th>
<th>OLAP Role</th>
<th>Analysis Role</th>
<th>Programmi ng Role (in SAS Enterprise Guide only)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Rapid Predictive Modeler</strong></td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Create a predictive model using SAS Enterprise Miner procedures.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Recency, Frequency, and Monetary Analysis</strong></td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Identify existing customers who might respond to a new campaign or product offer.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

### Registering Custom Tasks as Capabilities

#### Overview

Custom add-in tasks are .NET assemblies (DLL files) that you create, deploy, register, and execute from the SAS ribbon in Microsoft Office applications.

To provide access to custom tasks based on the job responsibilities in your organization, you can perform these actions:

- register custom tasks as capabilities
- assign capabilities
- assign users to roles

#### Create Custom Tasks

To create custom tasks, you develop Windows executables and package them as .NET assemblies. It is convenient to assemble multiple tasks in a single .NET assembly so that you can share code and implementation among the tasks. For
Deploy Custom Tasks

You can deploy custom tasks in two ways, using drop-in deployment or add-in deployment. Drop-in deployment copies .NET assemblies into specific local directories that are recognized by SAS Enterprise Guide and SAS Add-In for Microsoft Office. Custom tasks in drop-in directories are automatically registered (made available for execution) the next time the user starts SAS Enterprise Guide or a Microsoft Office application.

Add-in deployment copies .NET assemblies into any local directory. You then identify those directories for use in SAS Enterprise Guide or SAS Add-In for Microsoft Office using the Add-In Manager in SAS Enterprise Guide. Deployment registration makes the custom tasks available for execution from the SAS ribbon in Microsoft Office applications.

When you deploy your custom tasks, be sure to include any dependent assemblies that are referenced by those tasks. At the same time, ensure that you do not include any dependent assemblies that are provided by SAS Enterprise Guide or SAS Add-In for Microsoft Office.

To use the Add-In Manager:

1. Copy the .NET assembly into one of these directories:
   - C:\ProgramFiles\SASHome\application name\version\Custom
     
     application name is either EnterpriseGuide or Add-InForMicrosoftOffice.
   - %appdata%\SAS\application name\version\Custom
     
     %appdata% is the Microsoft Window environment variable that maps to a user account. Repeat the copy in other user accounts if multiple users run SAS Add-In for Microsoft Office on the same host.
   - %appdata%\SAS\SharedSettings\version\Custom
     
     Use this method to deploy custom tasks to specified user accounts, using a shared directory that is accessed by both SAS Enterprise Guide and SAS Add-In for Microsoft Office.

2. Restart SAS Enterprise Guide or the Microsoft Office application to register the custom tasks.

Follow these steps to use add-in deployment:

1. Copy the .NET assembly into any local directory.


3. In the Add-In Manager dialog box, select Browse .

4. Navigate to the directory where you stored your .NET assembly.

5. Click Open to display the names of the custom tasks in the assembly.

6. Click OK to accept the custom tasks and register them in SAS Enterprise Guide.
Register Custom Tasks as Capabilities

Follow these steps to register custom tasks as capabilities:

   - In the installation directory for SAS Enterprise Guide, double-click SEGExplorer.exe to open SAS Enterprise Guide Explorer.
   - In order for SAS Enterprise Guide Explorer to register tasks for use in SAS Add-In for Microsoft Office, the explorer must be started from the SAS Add-In for Microsoft Office installation folder. Launch the SAS Enterprise Guide Explorer by executing the file SEGExplorer.exe found in the SAS Add-In for Microsoft Office installation folder, which is usually C:\Program Files \SASHome\Add-InForMicrosoftOffice\version\SEGExplorer.exe.

2. In Explorer, select Tools ⇒ Task Import Wizard.

3. In the first page of the Task Import Wizard, you see your current metadata profile connection. If you need to connect with a different profile, click Cancel to close the wizard and select File ⇒ Manage Profiles. After you change your profile, click Close. Start the Task Import Wizard.

4. On the second page of the Task Import Wizard, select All known locations on this computer. Selecting this option ensures that the custom tasks that you registered with the Add-In Manager are registered in metadata by the Task Import Wizard.

   To find custom tasks, the Task Import Wizard looks for the file AddInRegistry.xml, which is created by the Add-In Manager. If you selected Common registry in the Add-In Manager, the path to AddInRegistry.xml is C:\ProgramData\SAS\BIClientTasks\4\AddInRegistry. If you selected User registry in the Add-In Manager, the path to AddInRegistry.xml is C:\Users\your-user-ID\AppData\Roaming\SAS\BIClientTasks\4\AddInRegistry.

5. Select tasks to receive metadata. Click Finish on the sixth wizard page to create metadata.

If you are unable to create metadata, you might need to install the package named SAS Enterprise Guide Server Data or SAS Add-In for Microsoft Office Server Data on the host that contains your current metadata repository.

Apply Custom Task Capabilities to Roles

Follow these steps to apply custom task capabilities to roles:

1. In SAS Management Console, open the User Manager.

2. To create a role for your custom task capabilities, right-click in the User Manager and select New ⇒ Role.

3. To add a custom task capability to an existing role, double-click an Enterprise Guide or Add-In for Microsoft Office role.
4. In the role properties window, click the **Capabilities** tab.

5. Expand the **Plug-Ins** branch in the tree view.

6. Click the custom task capabilities that you want to add to that role.

7. Click **OK**.

The custom task capabilities are applied to the role the next time affected users initialize SAS Enterprise Guide or a Microsoft Office application.
Common Administration Tasks

Overview

Because SAS Enterprise Guide and SAS Add-In for Microsoft Office share a SAS Metadata Server, some administration tasks are common to both applications.
Access the Help Using Local PDF Files

About the Documentation for SAS Enterprise Guide and SAS Add-In for Microsoft Office

The documentation for SAS Enterprise Guide and SAS Add-In for Microsoft Office is available from Help Centers on support.sas.com. This documentation includes a user’s guide, reference documentation for the tasks, an administrator’s guide, help for SAS Enterprise Guide Explorer and the Migration Wizard, and accessibility documentation. It also includes SAS 9.4 and SAS Viya programming documentation.

When you open the Help, press F1, or click Help in SAS Enterprise Guide or SAS Add-In for Microsoft Office, a web browser opens the Help Center for SAS Enterprise Guide or SAS Add-In for Microsoft Office. By default, you see the HTML version of the context-sensitive help. From the Help Center, you can also access the PDF version and EPUB versions of the documentation.

If your site does not have web access and you try to open the Help from the application, you will see an error. The administrator needs to configure SAS Enterprise Guide and SAS Add-In for Microsoft Office to use a local PDF version of the documentation. You download PDF versions of the documentation from SAS. Then you configure SAS Enterprise Guide or SAS Add-In for Microsoft Office to access this documentation from the application’s installation directory or from a custom location. After you complete this configuration, pressing F1 or clicking Help in SAS Enterprise Guide or SAS Add-In for Microsoft Office should open the context-appropriate Help topic in the locally saved PDF.

Accessing Help from the Installation Directory

To configure SAS Enterprise Guide to access the Help in the installation directory:

1. In your SAS Enterprise Guide installation directory, create a folder called Help. An example of this directory path is C:\Program Files (x86)\SASHome\x86\SASEnterpriseGuide\8\Help.


Note: From the download site, select all the PDF files that you need. For Help ⇒ SAS Enterprise Guide help and the context-sensitive Help (pressing F1 and clicking a Help button) to work in SAS Enterprise Guide, you must download the User’s Guide and SAS Tasks in SAS Enterprise Guide and SAS Add-In for Microsoft Office.
3 Unzip the file in the Help directory. Now, the Help directory contains the `language-abbreviation\EGUIDE_8.1\egdoccdc` subdirectory. This subdirectory contains the PDF files that you need.

In the directory path, `language-abbreviation` identifies the language of the PDF files. For example, if you download the English version of these docs, `language-abbreviation` is `en`.

---

**Note:** In Windows environments, permissions to the `C:\Program Files` directory are restricted. You might not be able to extract the PDF files directly to the Help folder. You could extract the PDF to another location, and then copy it into the Help directory. If a confirmation window appears, click **Continue**.

For the Help to work correctly, verify that the directory path for the PDF files is `Help\language-abbreviation\EGUIDE_8.1\egdoccdc`.

If you do not have permission to access the `C:\Program Files` directory, you must specify a custom location. For more information, see “Access the PDF Files from a Custom Location” on page 92.

---


To configure SAS Add-In for Microsoft Office to access the Help in the installation directory:

1 In your SAS Add-In for Microsoft Office installation directory, create a folder called `Help`. An example of this directory path is `C:\Program Files (x86)\SASHome\x86\SASAddInforMicrosoftOffice\8\Help`.


---

**Note:** For **Help ⇒ Help for SAS Add-In for Microsoft Office** and the context-sensitive Help (pressing F1 and clicking a **Help** button) to work in SAS Add-In for Microsoft Office, you must download the User’s Guide and SAS Tasks in SAS Enterprise Guide and SAS Add-In for Microsoft Office.

---

3 Unzip the file in the Help directory. Now, the Help directory contains the `language-abbreviation\MSOFFICEINT_8.1\amodoccdc` subdirectory. This subdirectory contains the PDF files that you need.

In the directory path, `language-abbreviation` identifies the language of the PDF files. For example, if you download the English version of these docs, `language-abbreviation` is `en`.

---

**Note:** In Windows environments, permissions to the `C:\Program Files` directory are restricted. You might not be able to extract the PDF files directly to the Help folder. You could extract the PDF to another location, and then copy it into the Help directory. If a confirmation window appears, click **Continue**.

When you are finished, verify that the directory path for the PDF files is `Help\language-abbreviation\MSOFFICEINT_8.1\amodoccdc`. You must have this directory path for the Help to work correctly.
If you do not have permission to access the C:\Program Files directory, you must specify a custom location. For more information, see “Access the PDF Files from a Custom Location” on page 92.

4 To test that the Help is working correctly, open SAS Add-In for Microsoft Office and select Help ⇒ Help for SAS Add-In for Microsoft Office. The SAS Add-In for Microsoft Office: User’s Guide opens in your default application for PDF files.

Access the PDF Files from a Custom Location

You can also save these PDF files in a custom location. If you use a custom location, you must specify the directory that contains these PDF files by using the CustomLocalHelpLocation configuration property in the SAS Enterprise Guide and SAS Add-In for Microsoft Office configuration files.

To specify a custom location for SAS Enterprise Guide:

1 In a text editor, open SEGuide.exe.config in the SAS Enterprise Guide installation directory.

2 Add this code to the appSettings element:

```xml
<appSettings>
  <add key="CustomLocalHelpLocation" value="path-to-local-PDFs" />
</appSettings>
```

The value for path-to-local-PDFs should be the directory where you extracted the ZIP file. An example of this directory is C:\customHelpLocation. This value should not be the directory that contains the PDF files.

Note: An example appSettings element might already exist in the configuration file. If this element is commented out, be sure to uncomment it. Otherwise, the element is ignored.

3 Save your changes.

4 Download the ZIP file from https://documentation.sas.com/download?softwareID=EGUIDE&softwareVersion=8.1 to your custom Help location.

5 Unzip the file and verify that the directory path is customHelpLocation \language-abbreviation\EGUIDE_8.1\egdoccdc.


To specify a custom location for SAS Add-In for Microsoft Office:

1 Open the SAS.OfficeAddin.dll.config file in the installation directory for SAS Add-In for Microsoft Office.

2 Add this code to the appSettings element:

```xml
<appSettings>
  <add key="CustomLocalHelpLocation" value="path-to-local-PDFs" />
</appSettings>
```
The value for *path-to-local-PDFs* should be the directory where you extracted the ZIP file. An example of this directory is `C:\customHelpLocation`. This value should not be the directory that contains the PDF files.

---

**Note:** An example `appSettings` element might already exist in the configuration file. If this element is commented out, be sure to uncomment it. Otherwise, the element is ignored.

---

3. Save your changes.


5. Unzip the file and verify that the directory path is `customHelpLocation\language-abbreviation\MSOFFICEINT_8.1\amodoccdc`.

6. To test that the Help is working correctly, open SAS Add-In for Microsoft Office and select **Help ▶ Help for SAS Add-In for Microsoft Office**. The **SAS Add-In for Microsoft Office: User’s Guide** opens in your default application for PDF files.

---

**Configure the Help for the SAS Enterprise Guide Explorer or the Migration Wizard**

SAS Enterprise Guide Explorer and the Migration Wizard are separate components in the SAS Enterprise Guide and SAS Add-In for Microsoft Office installations. The documentation for these components is available from the SAS Enterprise Guide and SAS Add-In for Microsoft Office Help Centers, so you can download the PDF files for these components using the previous steps. However, any context-sensitive Help does not work. For example, if you select **Help ▶ SAS Enterprise Guide Explorer help** or click a **Help** button, you do not see the context-sensitive Help.

You must perform additional configuration steps to configure the context-sensitive Help in SAS Enterprise Guide Explorer and the Migration Wizard.

---

**Note:** The executables for SAS Enterprise Guide Explorer (`SEGExplorer.exe`) and the Migration Wizard (`MigrationWizard.exe`) are available from both the SAS Enterprise Guide and SAS Add-In for Microsoft Office installation directories. If you are opening these components from both installation directories, these steps must be completed for both applications.

---

To access these PDF files to your **Help** directory:

1. Download the ZIP files from these locations:

2. Unzip the file in the **Help** directory and verify the directory paths:
   - The directory path for SAS Enterprise Guide Explorer should be **Help \language-abbreviation\EXPLORER_8.1**.
The directory path for the Migration Wizard should be `Help\language-abbreviation\MIGWIZ_8.1`.

To test that the Help is working correctly, double-click SEGExplorer.exe (for SAS Enterprise Guide Explorer) and MigrationWizard.exe (for the Migration Wizard) in the application's installation directories.


To access these PDF files from a custom Help location:

1. In the installation directory for SAS Enterprise Guide or SAS Add-In for Microsoft Office, create these configuration files:
   - SEGExplorer.exe.config for SAS Enterprise Guide Explorer
   - MigrationWizard.exe.config for the Migration Wizard

2. In the configuration files, add this code to the `appSettings` element:
   ```xml
   <appSettings>
     <add key="CustomLocalHelpLocation" value="path-to-local-PDFs" />
   </appSettings>
   ```

   The value for `path-to-local-PDFs` should be the directory where you extracted the ZIP file. An example of this directory is `C:\customHelpLocation`.

   Save your changes.

3. Download the ZIP file from these locations:

4. Unzip the file and verify the directory paths.
   - The directory path for SAS Enterprise Guide Explorer should be `customHelpLocation\language-abbreviation\EXPLORER_8.1`.
   - The directory path for the Migration Wizard should be `customHelpLocation\language-abbreviation\MIGWIZ_8.1`.

5. To test that the Help is working correctly, double-click SEGExplorer.exe (for SAS Enterprise Guide Explorer) and MigrationWizard.exe (for the Migration Wizard) in the application's installation directories.
   - When the Migration Wizard opens, click **Help**. The PDF of the *SAS Enterprise Guide and SAS Add-In for Microsoft Office: Migration Wizard User’s Guide* opens in your default application for PDF files.
Encryption

The `%appdata%` environment variable points to the user-specific application data area where the keyfile.txt file must exist. In SAS Enterprise Guide 8.1 and SAS Add-In 8.1 for Microsoft Office, the keyfile.txt file can be placed into each user’s `%appdata%\SAS\MetadataServerProfiles\` folder to provide a site-defined key that is used strictly for encrypting passwords that are stored on disk by the application. If a site-defined key is not used, a user-specific key is generated and used on that machine. The `keyfile.txt` file needs to be placed on the machine where the software is being installed, for the user who is running it.

The ConfigurationV#.xml file and VAServers.xml file can be decrypted by the software that knows both the algorithms that are used and has access to the `keyfile.txt` file.

Library Access

When you create a library using SAS Management Console, the library is defined on the SAS Metadata Server, and the library assignment is shared across SAS servers. In SAS Enterprise Guide, access to registered libraries is determined in part by the method that is used to assign those libraries.

The library assignment methods that you select in SAS Enterprise Guide also apply to SAS Add-In for Microsoft Office.

For information about library management, see *SAS Intelligence Platform: Data Administration Guide*.

To ensure appropriate library access for each SAS Enterprise Guide client, complete these steps:

1. Review the library assignment method based on the access requirements of the SAS Enterprise Guide client and the access controls on the registered libraries.

   Note: The library assignment method can be modified within SAS Management Console by modifying the value of the `AssignMode` extended attribute as described in the following items.

The library assignment methods are defined here:

**SAS Enterprise Guide**

assigns the library based on the engine and `LIBNAME` statement options that are defined on the SAS Metadata Server. When you choose this library assignment method, SAS Enterprise Guide ignores table and column metadata access control (Read, Write, Create, Delete).
Note: This assignment method is indicated in SAS Management Console by setting the value of the AssignMode extended attribute to 0.

Use this library access method when the client requires Write access to the library, and when the tables in the library are not subject to access control. If Write access to a registered library is not required, use Metadata Library Engine.

Write access to registered libraries should be closely monitored because the SAS code that is generated by SAS Enterprise Guide does not automatically synchronize metadata. Changes to columns are written into the physical table, but are not written into the table metadata.

Note: You can edit the code that is generated by SAS Enterprise Guide to include the METALIB procedure, which can be used to update table metadata. You can also use the Update Library Metadata task to refresh the library metadata.

SAS Server

assumes that the library is pre-assigned on the SAS server using an AUTOEXEC or the METAAUTOINIT process that runs when the server is initialized. Metadata access control for tables and columns is enforced only if the pre-assignment uses the Metadata Library Engine.

Use this library access method to assign a library consistently across clients. The clients include SAS Enterprise Guide, SAS Add-In for Microsoft Office, and the SAS Stored Process Server. Note that this assignment method is indicated in SAS Management Console by setting the value of the AssignMode extended attribute to 3.

Metadata Library Engine

assigns the library using the metadata LIBNAME engine. By default, the library is Read-Only. You cannot add or create tables, and SAS Enterprise Guide displays registered tables only. Use this library assignment method to protect the referential integrity of the table metadata. This method is recommended for OLAP cube libraries.

To enable Write access at the library level and enforce metadata access control at the table and column level, deselect the check box labeled Show only tables with metadata definitions. With this library access method, SAS Enterprise Guide displays all of the tables in the library, including any tables that are not registered.

Note: This assignment method is indicated in SAS Management Console by setting the value of the AssignMode extended attribute to 1, 2, or 4. When the value is 1 or when AssignMode is not specified, only registered tables are shown. When the value is 2, both registered and unregistered tables are shown. When the value is 4, only registered tables are shown. Tables can be created, as described in About the Metadata LIBNAME engine.

2 If the assignment method for the selected library does not meet the needs of the SAS Enterprise Guide client, use SAS Management Console. SAS Management Console is used to change the library assignment, create libraries, or change access permissions.
3 At a minimum, make sure that you review the assignment methods for all of the registered libraries that require Write access from SAS Enterprise Guide clients.

4 Creating and modifying library metadata affects all users of the altered library in all applications. Therefore, administrators might consider disabling the ability of users to modify library metadata. This can be done by restricting Write access to specific library objects by using SAS Management Console, or by denying users the Update Library Metadata and Create Library Metadata role capabilities.

---

**Configure Access to a Locked-Down Server**

Six types of SAS servers can be configured to run in a high-security locked-down mode: workspace, pooled workspace, stored process, batch, grid, and SAS/CONNECT. When a server is locked down, it can access only specified resources on the host file system. The server also cannot run or invoke a number of SAS language elements that access the host file system.

To enable SAS Enterprise Guide and SAS Add-In for Microsoft Office to access a locked-down server, the default starting point needs to be a location that is enabled for access. To learn how to change the default starting point, and to learn more about locked-down servers, see the *SAS Intelligence Platform: Security Administration Guide*.

---

**Configure Your Environment to Use the Upload to CAS Task**

**Configure a SAS/CONNECT Server**

A SAS spawner is a program that starts a SAS session on the server on behalf of a connecting client.

The Upload to CAS task in SAS Enterprise Guide and SAS Add-In for Microsoft Office requires a SAS/CONNECT spawner to be running on both your SAS server and your CAS server. This is done by installing SAS/CONNECT software on the SAS server and on the CAS server.

To configure a SAS/CONNECT server, open SAS Management Console and complete these steps:

1 Right-click **Server Manager**. Select **New Server**.

2 Scroll down to the **SAS Application Servers** folder. Click **Next**.

3 Enter a name for the SAS Application Server in the **Name** field (for example, SASappServer). The **Description** is optional. Click **Next**.
4 Keep the SAS software version defaults and click Next. The **SAS Application Servers** folder appears.

5 Click **Connect Server**. Click Next.

6 Click **Basic**. Change the **Authentication Domain**, **Host Name**, and **Port Name**, or accept the defaults. Click Next.

7 Verify the information. Click **Finish**.

---

**Configure a SAS/CONNECT Spawner on the SAS Server and the CAS Server**

To provide metadata information about the SAS/CONNECT spawner running in the SAS server, open SAS Management Console and complete these steps:

1 Right-click **Server Manager**. Select **New Server**.

2 Scroll down to the **Spawners** folder. Click **Connect Spawner**. Click Next.

3 Enter a name for your SAS/CONNECT spawner in the **Name** field (for example, ConnectSpawner). The **Description** is optional. Click Next.

4 Leave the defaults for **Signon Scripts Allowed** and **Associated machine**. Click Next.

5 In the left column in **Available servers**, select **SASApp - Connect Server**. Use the arrow to move the server to the **Selected servers** column. Click Next.

6 Select the **Authentication Type** and the **Authentication Domain**. The **Operator Port** is a default. Click Next.

7 Verify the information, and then click **Finish**.

---

**Add Three Objects to the Metadata**

In order to use the Upload to CAS task, you need to add three more objects to the metadata that are related to SAS Viya:

- a SAS/CONNECT server object pointing to a CAS session
- a SAS Viya CAS server object
- a CAS library object

**SAS/CONNECT Server Object**

If you have the fourth maintenance release of SAS 9.4 or later, complete these steps to point the SAS/CONNECT server object to a CAS session.

1 In SAS Management Console, click **SAS/CONNECT Server**.
2. Go to Properties. Enter the Remote Host name, Remote Session ID (for example, bridge), and the Port.

3. Click OK.

**CAS Server Object**

To create the CAS Server object, complete these steps:

1. Click Viya CAS Server and open Properties.

2. Click Options. Enter the Server name and Port.

3. Click OK.

**CAS Library Object**

To create the CAS library object, complete these steps:

1. Click CAS library.

2. Go to Properties.

3. Click Assign to ensure that you have assigned the CAS Connect server.

4. Click Options. The Libref and CASLIB names appear (for example, demodata).

5. Go to your SAS Viya session in SAS Environment Manager to ensure that the CASLIB name is correct.

---

**Tasks That Require Other SAS Software**

SAS Enterprise Guide and SAS Add-In for Microsoft Office include tasks that require the use of other SAS software.

- The SAS Forecast Studio tasks require the installation of the SAS Forecast Server software.
- The Rapid Predictive Modeler task requires the installation of the SAS Enterprise Miner software.

To run the tasks that use SAS Forecast Server or SAS Enterprise Miner, your role requires certain capabilities. The Rapid Predictive Modeler task runs only on SAS 9.3 and 9.4 servers. The other tasks run on SAS 9.2, 9.3, and 9.4 servers.

---

**Configuration Properties**

The following configuration properties are available:
Table 6.1  Configuration Properties

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CustomLocalHelpLocation</td>
<td>Specifies the location of PDF files used for documentation. For more information, see “Access the Help Using Local PDF Files” on page 90.</td>
</tr>
<tr>
<td>ExploreDataByDefault</td>
<td>Specifies whether to open data in the Data Explorer or the data grid when you double-click the data item in the Servers pane or SAS Folders pane.</td>
</tr>
<tr>
<td></td>
<td>When this property is set to true, the data opens in the Data Explorer by default. If you do not set this property or it is set to false, the data opens in the data grid.</td>
</tr>
</tbody>
</table>